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I. Introduction 

This manual aims to provide insights into potential applications of the Advene annotation 

software (Aubert & Prié 2005; www.advene.org) for film and media studies. We will attempt to 

describe the capabilities of this software in a detailed, structured way that will provide easy 

access for both new and experienced users. This document is a product of the “Audio-visual 

Rhetorics of Affect” junior research group funded by the German Federal Ministry of Education 

and Research (BMBF). It documents the stages of analysis through corroboration with the AdA 

Filmontology, an eMAEX based analysis vocabulary developed within the project. 

The manual features three different entry points: 

 

● The Quick Start Guide (II) provides a direct, uncomplicated introduction, in which the 

most basic functionality of the software is explained in a step-by-step manner. 

● Advene Basics (III) features detailed explanations of the most important controls, 

features, settings, and usage tips for using the Advene annotation software. The 

explanations were designed to loosely follow the chronology of an annotation process 

(starting with the interface, followed by the fundamental settings for creating and editing 

annotations, and ending with instructions for visualizing, evaluating, and exporting the 

annotations to different formats). The wealth of detail provided should make this section 

work as a non-linear reference database. 

● The section on Working with the AdA Filmontology (IV) follows the individual stages of 

a complete annotation process of the analysis system developed within the project – 

from tips for the (semi-)automatic shot segmentation to exporting analysis data to an 

adjustable html timeline. This systematized procedure can be translated to other 

research projects as well. 

 

This manual is therefore suitable for very different user groups: beginners who want to discover 

whether video annotations are a useful tool in their film analyses; Advene users who are 

looking for deeper insights into the range of features the program offers; film and media 

scholars who wish to incorporate this methodological approach into their analysis of filmic 

expressivity and rhetorics of affect. The manual provides numerous internal and external links 

that facilitate quick navigation between the various tutorial sections. 

All resources mentioned in this manual are free to use and open-source. In selecting them we 

hope to provide equal access to the techniques and practices of digital film analysis for 

students, researchers, and anyone interested. 

The manual is available in German and English and is offered under a Creative Commons 

Attribution ShareAlike 3.0 license, i.e. it can be distributed and modified freely. The manual is 

only a part of the available documentation and can be used in tandem with other publications 

from our research project. “AdA Filmontology – Levels, Types, Values” is an overview of the 

analytical concepts in the AdA Filmontology which can also serve as inspiration for the 

composition of other film analysis vocabularies. “Hinweise zum kollaborativen Annotieren mit 

der AdA-Filmontologie“1 provides specific suggestions for concrete usage of the AdA 

Filmontology in project contexts where several analysts are working simultaneously with an 

extensive film corpus they wish to describe consistently. In such cases, reaching 

intersubjective agreement for specific analytical decisions is essential, and this is a result of 

project-specific coordination processes between expert annotators. 

 
1 So far, this document is only available in German. 

http://www.advene.org/
https://www.empirische-medienaesthetik.fu-berlin.de/media/emaex_methode_deutsch/eMAEX-_-Ansaetze-und-Potentiale-einer-systematisierten-Methode-zur-Untersuchung-filmischer-Ausdrucksqualitaeten.pdf
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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The “Audio-visual Rhetorics of Affect” Project (AdA) 

The eHumanities junior research group “Audio-visual rhetorics of affect” (2016-2021)2, funded 

by the German Federal Ministry of Education and Research (BMBF), was a cooperation 

between the Freie Universität Berlin Film Studies Department (Seminar für Filmwissenschaft) 

and the Hasso-Plattner Institute for Digital Engineering in Potsdam. Project Director: Jan-

Hendrik Bakels. Research Fellows: Jasper Stratil and Thomas Scherer (FU), Henning Agt-

Rickauer and Christian Hentschel (HPI). Assisted by: Olivier Aubert, Matthias Grotkopp, and 

Joscha Jäger. Student Assistants: Anton Buzal, Yvonne Pfeilschifter, João Pedro Prado, 

Rebecca Zorko, and Maximilian Steck. Under the mentorship of Hermann Kappelhoff and 

Harald Sack. 

 

https://www.ada.cinepoetics.fu-berlin.de/en/index.html 

https://projectada.github.io 

https://github.com/ProjectAdA 

 

The underlying eMAEX-Systematic was further developed by the film scholars working in the 

Cinepoetics – Center for Advanced Film Studies and the methodological developments of the 

AdA project can be found at: 

 

http://www.cinepoetics.fu-berlin.de/en/index.html  

https://www.empirische-medienaesthetik.fu-berlin.de/en/emaex-

system/emaex_kurzversion/index.html  

 

The AdA Filmontology 

The AdA Filmontology consists of a machine-readable film analysis vocabulary that took 

eMAEX as a point of departure. Because of this, film analysis attributes for video segments 

can be exported as Linked Open Data. The filmontology has a threefold structure and 

encompasses eight levels, 78 types, and 503 values, all of which are defined in both German 

and English. 

 

The AdA Filmontology is available under a Creative Commons Atttribution-ShareAlike 3.0 

license. 

 

For more detailed information, see: https://projectada.github.io/ontology/ 

 

  

 
2 In German: “Affektrhetoriken des Audiovisuellen”, or “AdA”. 

https://projectada.github.io/
https://github.com/ProjectAdA
http://www.cinepoetics.fu-berlin.de/en/index.html
https://www.empirische-medienaesthetik.fu-berlin.de/en/emaex-system/emaex_kurzversion/index.html
https://www.empirische-medienaesthetik.fu-berlin.de/en/emaex-system/emaex_kurzversion/index.html
https://projectada.github.io/ontology/
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Publications 

● Bakels, Jan-Hendrik/Grotkopp, Matthias/Scherer, Thomas/Stratil, Jasper. “Matching 

Computational Analysis and Human Experience. Performative Arts and the Digital 

Humanities”. Digital Humanities Quarterly 14(4), 2020. 

● Bakels, Jan-Hendrik/Grotkopp, Matthias/Scherer, Thomas/Stratil, Jasper. “Digitale 

Empirie? Computergestützte Filmanalyse im Spannungsfeld von Datenmodellen und 

Gestalttheorie”. In: montage/AV 29(1), 2020, pp. 99–118. 

● Bakels, Jan-Hendrik/Scherer, Thomas/Stratil, Jasper/Agt-Rickauer, Henning. “AdA-

Filmontology – a machine-readable Film Analysis Vocabulary for Video Annotation”. 

Konferenzbeitrag für: DH2020 – carrefours/intersections, 2020. 

● Scherer, Thomas/Stratil, Jasper. “Can’t Read my Broker Face? – Tracing a Motif and 

Metaphor of Expert Knowledge Through Audiovisual Images of the Financial Crisis”. 

Literature Compass. In press. 

● Stratil, Jasper. “’Ja es ist wieder Zeit für so ein Video.’ Zur audiovisuellen Adressierung 

und rhetorischen Situation des Rezo-YouTube-Videos Die Zerstörung der CDU’“. 

mediaesthetics – Journal of Poetics of Audiovisual Images, 2020. 

● Various contributions by Anton Buzal, Jan-Hendrik Bakels, Matthias Grotkopp, Yvonne 

Pfeilschifter, João Pedro Prado, Thomas Scherer, Jasper Stratil and Rebecca Zorko 

in: “Digital Film Analysis and Images of Crisis”, in mediaesthetics #4 2021.  

● Agt-Rickauer, Henning/Aubert, Olivier/Hentschel, Christian/Sack, Harald. “Authoring 

and Publishing Linked Open Film-Analytical Data”. EKAW Posters and Demos 2018. 

Nancy, 2018. 

● Agt-Rickauer, Henning/Hentschel, Christian/Sack, Harald: “Semantic Annotation and 

Automated Extraction of Audio-Visual Staging Patterns in Large-Scale Empirical Film 

Studies”. 14. International Conference on Semantic Systems (SEMANTiCS 2018), 

2018. 

 

Advene 

Advene is a freely available open-source software program for video annotation and 

hypervideo authoring (for Linux, Windows, and MacOS). It provides a variety of different, highly 

customizable features. Through close collaboration with Olivier Aubert, we have expanded 

Advene so that users without a background in programming may be able to easily generate 

and visualize semantic film analysis data according to the AdA Filmontology. We have 

therefore made numerous changes to optimize the user interface and options for visualization. 

Resources 

● http://advene.org/  

● Advene Wiki: https://github.com/oaubert/advene/wiki (user manual, FAQ, etc.) 

● Aubert, Olivier/Prié, Yannick: “Advene: active reading through hypervideo.“ Conference 

paper at: ACM Hypertext'05, 2005. 

  

http://www.digitalhumanities.org/dhq/vol/14/4/000496/000496.html
http://www.digitalhumanities.org/dhq/vol/14/4/000496/000496.html
http://www.digitalhumanities.org/dhq/vol/14/4/000496/000496.html
https://dh2020.adho.org/wp-content/uploads/2020/07/488_AdAFilmontologyamachinereadableFilmAnalysisVocabularyforVideoAnnotation.html
https://dh2020.adho.org/wp-content/uploads/2020/07/488_AdAFilmontologyamachinereadableFilmAnalysisVocabularyforVideoAnnotation.html
https://www.mediaesthetics.org/index.php/mae/article/view/83/207
https://www.mediaesthetics.org/index.php/mae/article/view/83/207
http://www.mediaesthetics.org/index.php/mae/issue/view/12/showToc
https://www.researchgate.net/profile/Henning-Agt-Rickauer/publication/328902207_Authoring_and_Publishing_Linked_Open_Film-Analytical_Data/links/5bea9fc4a6fdcc3a8dd211f0/Authoring-and-Publishing-Linked-Open-Film-Analytical-Data.pdf
https://www.researchgate.net/profile/Henning-Agt-Rickauer/publication/328902207_Authoring_and_Publishing_Linked_Open_Film-Analytical_Data/links/5bea9fc4a6fdcc3a8dd211f0/Authoring-and-Publishing-Linked-Open-Film-Analytical-Data.pdf
https://www.fiz-karlsruhe.de/sites/default/files/FIZ/Dokumente/Forschung/ISE/Publications/Agt-Rickauer-Semantics-2018.pdf
https://www.fiz-karlsruhe.de/sites/default/files/FIZ/Dokumente/Forschung/ISE/Publications/Agt-Rickauer-Semantics-2018.pdf
https://www.fiz-karlsruhe.de/sites/default/files/FIZ/Dokumente/Forschung/ISE/Publications/Agt-Rickauer-Semantics-2018.pdf
http://advene.org/
https://github.com/oaubert/advene/wiki
https://dl.acm.org/doi/pdf/10.1145/1083356.1083405?casa_token=54W-BnqOQDoAAAAA:vOHdSvrNek3RWWF2esW-kfg0h7pDoZ6dGS-NBY1W3-9Fnjfh9EnZ1uCiqLjxtQujzMah5LjzmPka
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II. Quick Start Guide 

Welcome to the Advene Quick Start Guide! The purpose of this section is to provide a basic 

overview of the software and thereby enable users to conduct simple analyses without needing 

to explore the program in more detail. 

 

Installation 

The current version of Advene (3.13) is available for Linux-, MacOS and Windows-based 

systems and can be downloaded from advene.org. 

 

Setup: package and video files 

Advene was designed as a video annotation tool, which means that at the center of the process 

is a video file of the research object, as well as the metadata generated in Advene in the form 

of a “package” with the Advene-specific suffix “.azp”. This package is the file that contains all 

annotations for a specific video file. A new, empty package will always be generated 

automatically when starting Advene. 

Aside from setting up a new, empty package from scratch, it is also possible to work with other 

already available packages, such as a template with predefined analysis systematics. One of 

these systematics is the previously mentioned AdA Filmontology, the template of which can 

be accessed under this link (for more on the AdA template, see section IV. Working with the 

AdA Filmontology). To access an existing package, click on the “File” menu and select “Open 

package”. 

Since each package contains the annotations corresponding to a specific video, the latter must 

be linked manually. To do this, open the “File” menu and select “Associate a video file”. To 

check that the correct video file has been selected: after linking the package and the video file, 

press the Play button of the video player; this is just to see if image and sound are being 

rendered properly. 

 

Interface / Views 

Once the package and video files are open, annotations appear in a feature strip on the bottom 

strip of the user interface, called “Timeline”. The Timeline area looks like the classic timeline 

view of various video editing software programs, in which clips are arranged consecutively. 

This is primarily where the annotations and annotation types can be edited. The Timeline is 

only one of several so-called “Views” available in Advene. Each View corresponds to another 

representation or visualization form for annotations. To put it in other words, a View always 

offers an alternate possibility for displaying annotations within the program. 

https://advene.org/download.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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The top menu of Advene features a series of buttons that can open these Views on the 

graphical user interface. Views can be activated either by clicking on these buttons, which 

automatically embeds them into the most suitable area of the display, or through dragging-

and-dropping the buttons into user-specified areas. Aside from the previously mentioned 

Timeline View, you can also use the Table View. The Timeline View displays annotations of 

the same type horizontally, in their chronological order (with particular focus on the 

representation of their duration); by contrast, the Table View displays the same annotations as 

a vertically-arranged table that can be sorted by various criteria. For more information on the 

individual visualization forms, see chapters 1.2 Timeline View, 1.3 Table View and 1.4 

Transcription View. 
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Creating annotations 

Now that the package and video have been loaded, you can begin working in the Timeline! 

 

In Advene, the selected video can be described on multiple levels (types), each of which having 

its own allocated annotations. An annotation type consists of a specific element pertaining to 

the image or sound of the loaded video, for example the camera angle or the music mood. 

Each type is graphically displayed as a bar on the left side of the Timeline; each bar has its 

own corresponding track where the annotations are arranged. 

 

You can manually show or hide annotation types (for instance, in order to visually declutter the 

user interface). 

You can choose which annotation types are displayed after clicking on the  symbol on the 

top left corner of the Timeline. This will open up a table; its left column displays the visible 

ones, while the right lists the ones that are hidden from view. Moving one from one column to 

the other can be done by clicking the arrow symbols in the middle of the table. Additionally, 

visible annotation types (so, on the left side of the table) can be reordered on the Timeline by 

dragging-and-dropping them vertically. 

 

After the desired annotation types have been selected, you can proceed with creating 

annotations. In order to create a new annotation, simply right-click with the mouse on the 

desired track and select “New annotation at mouse position” or “at player time”, depending on 

whether the new annotation should be generated after the position of the mouse pointer or 

based on the current video player timecode (the latter is, naturally, always the more precise 

option). If an annotation has been created at the wrong Timeline position, this can be rectified 

as follows: either through correcting the annotation boundary by dragging-and-dropping to 

another annotation of the track (the so-called “align” feature), or by editing the start and end 

times of the annotation individually (which can be done by using the “Edit” feature). In addition, 

performing such operations can be done much faster and easier through the use of Shortcuts. 
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Furthermore, annotations can be deleted, copied within the same track, as well as copied or 

moved to other tracks. A detailed description of all these processes and features can be found 

in 5.2 Creating and editing annotations. 

 

Once annotations have been created, they have to be assigned a value. Values are, simply 

put, the contents of annotations. If you are annotating using a package based on the AdA 

Template and you look, to take one example, at the track ImCo | Image Brightness, the 

available values for describing the brightness of the image are, based on this ontology, bright, 

medium, dark, and bright-dark. These values can be added in manually, either through the 

already mentioned “Edit” feature, or by pressing the Enter key on the keyboard (if the 

annotation has been selected on the Timeline). More on this in 5.3. Entering annotation values. 

Additionally, Advene offers two important basic features for generating certain annotations 

automatically. One of them is 5.4.2. ShotdetectApp importer, which creates a new annotation 

for each cut the program detects on the video track. The other is the creation of a waveform 

corresponding to the audio volume. This can be generated automatically through filter 5.4.1. 

Sound enveloppe (and, for the AdA template, it can be copied into the dedicated annotation 

type As | Volume). For that matter, the resulting annotation will not be represented in text form, 

but as a bar chart of numerical values. 

 

Aside from various possibilities for creating and editing annotations and views, Advene also 

provides ways to adjust them in order to suit different needs. To do this, go to “Preferences” in 

the “Edit” menu. This is where you can also activate and review certain basic settings before 

you start making annotations. Detailed information on these settings can be found in section 

2. Preferences of this user manual. 

 

Advene offers various features for visualizing the complex and delicate metadata records 

generated through annotations in different, insightful ways. Aside from the previously 

mentioned Views, which are primarily meant to serve in the annotation process, the output can 

also be rendered as dynamic subtitles, video montages, graphs, or statistics (see chapters 8. 

Visualizing annotations and 9. Statistical analysis. Importantly, annotations created in Advene 

can be exported for use in other programs, for instance as shot transcripts, as CSV or TSV 

files, and even as video clips. To see how this is done, check chapter 10. Exporting. 
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Checklist 

Do I have everything prepared? 

➢ current Advene version installed (3.13, June 2021) 

➢ video file (see III 4.) 

➢ already decided on an annotation vocabulary? See AdA Filmontology 

➢ Package template: AdA-Template.azp 

First steps in Advene 

➢ Open or create a package 

➢ Link a video file 

➢ Already checked the Advene settings? (for, e.g., framerate, see III 2.6.) 

… and you can start annotating 

➢ What should be annotated? 

○ Suggestion for Basic Tracks in the AdA Template as point of departure 

○ How can I create new annotation types? See III 5.1.1. 

➢ Producing annotations 

○ Automatic annotations? See e.g. shot detection or volume (III 5.4.) 

○ Manually creating (III 5.2.) and “filling” (III 5.3.) annotations 

➢ Check annotations? See III 6. 

➢ Visualize annotations? Cf. AdA-Timeline IV 7. 

Further work with annotations 

➢ Exporting to other software, e.g. as a table III 10. 

Exporting as AdA Timeline image (IV 7.1.4.) 

  

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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III. Advene Basics 

In the following pages, we will introduce the most important view modes, features, settings, 

and controls available in the Advene annotation software, the so-called Advene Basics. The 

order in which these individual sections have been arranged loosely follows the chronology of 

an annotation process. The detailed explanations provided should, however, make this section 

work primarily as a non-linear reference database. 

 

Advene is a freely available open-source software program that allows users (also those 

without a background in programming) to create, edit, and visualize annotations – for example, 

semantic film analysis data following the logic of the AdA Filmontology – that are temporally 

correlated with a video file. 

 

The following instructions and explanations do not seek to provide an exhaustive overview of 

the software; we have chosen to focus on the central features and methods we have been 

applying in the “Audio-visual Rhetorics of Affect” project. 

 

Note: For an actual introduction to the Advene software, you can consult the following 

tutorial screencasts: https://www.advene.org/screencasts.html#screencasts 

 

1. User Interface 

 

 

The screenshot above shows a typical workspace in Advene. At the very top is the menu bar, 

which allows you to access the various features of Advene. Directly below is the main toolbar, 

which provides direct access to certain important features and views. Also at the top, on the 

left side of the screen, the linked video file is being rendered in the Video player. 

 

https://www.advene.org/screencasts.html#screencasts
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Advene allows you to visualize annotation data in various ways, and also to edit these view 

modes. Certain view modes are better suited for certain specific tasks, and these view modes 

can be accessed either by clicking the corresponding icons in the toolbar, or by opening the 

“View” menu at the top. In the example above, you can see that the snapshots (preview images 

that Advene generates automatically during the annotation process) are being displayed on 

the left side of the screen, while the Table View is visible on the right side. This can also be 

replaced with the Transcription View, which can be especially useful for text-heavy 

annotations. For transcribing larger amounts of text, you can additionally use the Note-taking 

Editor. In the bottom area of the workspace, underneath the video player, you normally see 

the Timeline View. The Package Finder allows you to display all the elements and views 

contained within the package. 

 

Aside from these views, there are further modes of function-oriented visualization, such as the 

Checker, used to review the data input, or Montage, which allows you to create annotation-

based video compilations. 

 

Partitioning the User Interface  

It is possible to edit the standard workspace and display each view mode in a workspace of 

your choosing. Advene distinguishes between three areas, described in relation to the video 

player. 

 

 
 

In order to move an already opened view mode, you can right-click on it – in the example 

below, this view is the “Timeline” – and choose the option “Detach”, followed by the preferred 

position. Additionally, you can open a view in a new workspace to the right side of the current 

workspace, or in its own separate window. 

 

 
 

Tip: This also allows you to display several different instances of the Timeline View 

simultaneously. 
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Saving and loading a workspace 

In order to save a workspace, open the “File” menu and select “Save workspace” and “…as 

package view”. 

 

 
 

A pop-up window will appear and allow you to assign a name and an ID for the current 

workspace. You also have the possibility to set it as the standard, default workspace. 

 

 
 

All workspaces can be loaded and managed through the Package Finder. To do so, open the 

“View” menu and select “Package finder”. All available saved workspaces will be listed under 

“List of views” and “Adhoc views”. 
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1.1 Video player 

Video playback is, naturally, a central part of the annotation process. For this reason, we will 

proceed to briefly explain how to use the video player, retrieving media data, as well as using 

dynamic views. 

 

(For an illustrated step-by-step guide to linking a video file, see: Choosing and linking video files) 

 

 
 

1.1.1. Player controls 

The video player controls are designed to be very intuitive. By using Shortcuts, you can 

additionally simplify and accelerate your work process. 

 

The Play/ Pause button allows you to start and stop the video playback, respectively. 

Alternatively, you can use the key combinations [CTRL] + [space] and [CTRL] + [tab]. 

 

 

 
 

By clicking one of the double arrow symbols with a line at either the left or right end, pictured 

below, you can jump in the video one frame back or one frame forward, respectively. An 

alternate way to do this is to press the key combinations [CTRL] + [down] and [CTRL] + [up], 

respectively. 
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By clicking one of the double arrow symbols pointing left and right, respectively, you can jump 

in the video either backwards or forwards in larger increments. This can also be done by 

pressing the key combinations [CTRL] + [left] and [CTRL] + [right], respectively. 

 

 
 

The desired jump duration can be set to a certain value and changed at any point by going into 

the “Edit” menu, selecting “Preferences” and then “Time-related”. 

The “Time increment“ row refers to the double arrow symbol pointing left or right, respectively. 

In the example below, you can see a set value of 1,000 ms, which is to say one second per 

jump. 

 

 
 

Warning: The functionality of the arrow symbols and key combinations is changed as soon as 

the change in value is made under “Preferences”. In order to update the tooltip displayed when 

the mouse pointer hovers over these buttons, you have to restart Advene. 

 

    

If you click on the full-screen symbol, the video player will move into full-screen mode. You can 

quit this view mode by pressing the [esc] key. 
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The loudspeaker symbol can be clicked in order to adjust the volume, as well as in order to 

mute the sound completely. 

 

 
 

Playback speed can be changed either through the input window or by clicking on the plus and 

minus symbols. The normal playback speed has a value of 1.0. 

 

 
 

You can activate loop playback for the currently selected annotation by clicking on the blue 

circular arrow. The video segment corresponding to the annotation will then be played back in 

a continuous loop. 

 

If the annotation process requires viewing a segment multiple times, the loop function can be 

used to create an infinite loop of the currently selected annotation. This can, for instance, help 

you hear a certain recorded word that is difficult to understand, or to write extensive free-text 

descriptions of complex image compositions. 

 

 
 

1.1.2. Displaying media information 

In order to display media information for the linked video (Choosing and linking video files), 

open the “Player” menu and select “Display Media information”. 
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A window will open, and in it you can see information such as the video file path or the frame 

rate. 

 

 
 

1.1.3. Dynamic views (Caption Dynamic View) 

By right-clicking an annotation type in the Timeline View and selecting the option “Generate a 

caption dynamic view…”, you can create a dynamic view of the current track. 
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Dynamic views are automatically saved when created. They can be activated either in the 

Package Finder, under “List of views” and “Dynamic views”, or from the drop-down list directly 

above the video player. The latter will always display the currently active view. 

 

 
 

The content of annotations for the selected track will now be displayed within the video player, 

in the form of subtitles. 

 

 
 

This feature can be useful for a quick check of your annotations. 
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1.2. Timeline View 

In the Timeline View, annotations are graphically represented in their chronological order, and 

displayed according to their duration. The farther to the right of the Timeline an annotation is 

displayed, the closer its corresponding segment in the video file – for example, a film shot – is 

to the end of the video. The various annotation types are represented as individual lines (also 

referred to as tracks). Since this view mode makes it possible to visualize multiple annotation 

types simultaneously, the interplay of different levels of description can be analyzed more 

clearly. Additionally, this view mode makes it especially easy to create new, precise 

annotations. 

 

 
 

To open the Timeline View, drag and drop the Timeline icon from the toolbar into a Workspace. 

 

 
 

Tip: You can adjust how Timelines are displayed by going into the “Edit” menu and selecting 

“Preferences” and then "Timeline parameter". 

 

We will move on to briefly explain the Inspector as an element of the Timeline View, in particular 

the various features for adjusting the view mode, as well as saving and loading a Timeline 

View. 
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1.2.1. Inspector 

The “Inspector”, usually displayed on the right side of the Timeline, displays basic information 

on the currently selected annotation. This includes the annotation name, or (if it is active) the 

individual annotation UUID (highlighted in the color assigned to the annotation), its duration, 

as well as the start and end time of the annotation. Below this is an area labeled Screenshot, 

where a snapshot corresponding to the annotation is displayed. Contents displays the 

descriptive content of the annotation; in our example below, this is the field size corresponding 

to a shot. 

 

 
 

1.2.2. Selecting which annotation types to display 

The individual lines of the Timeline View each illustrate one annotation type. 

 

 
 

Since annotations are not usually added to every single available track, it can be helpful to 

choose only certain annotation types for display in the Timeline. By clicking on the multi-color 

square with a yellow hand symbol on it, you can toggle which annotation types are visible in 

the Timeline, as well as their vertical display order. 
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After you click on the square, a window will pop up; on the left side are the currently displayed 

annotation types in the Timeline, while on the right are the hidden annotation types. 

 

 
 

You can use the “<All<” and “>All>” buttons to move all annotation types from right to left and 

vice versa. To move an individual annotation type, select it (it will be highlighted in orange) and 

click on the “<<<” or “>>>” to move it from right to left and vice versa. The vertical order of 

annotation types can be adjusted by dragging-and-dropping. Once you have made your 

selections, confirm by pressing “OK”. 

 

The number displayed next to each annotation type is a counter that indicates how many 

annotations have already been added to the current track. 
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See below an example of what the Timeline can look like once you have made a selection of 

displayed annotation types: 

 

 

 

Tip: You can also drag and drop the tracks in the Timeline View in order to change their order. 

 

1.2.3. Scrolling Settings 

Several scrolling settings are available for the Timeline View. If the entire video runtime is not 

displayed in the Timeline, but rather a zoomed-in segment, you can use these settings to adjust 

if and how the segment displayed moves when playing the video. 

 

 
 

“No scrolling” makes the displayed area in the Timeline move only through manual scrolling, 

not automatically. 

 

“Continuous scrolling” makes the displayed area in the Timeline move continuously and in 

parallel to the video playback, so that the playhead – the vertical line that moves across the 

Timeline in tandem with the video player timecode – always stays in the middle. 

 

“Discrete scrolling” makes the playhead always move until the end of the displayed area. As 

soon as the playhead moves beyond the visible area, this area automatically shifts forward, so 

that the playhead is once again in the middle of the displayed area. 

 

“Annotation scrolling” makes the displayed area shift forward to a point where the playhead 

reaches a new annotation; it rearranges the displayed area so that the next annotation is 

situated in the middle. 
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1.2.4. Setting the zoom level 

The zoom level dialog box allows you to adjust the area displayed in the Timeline. This allows 

you, for instance, to zoom in on short shots in order to do detailed work, so that a shorter 

segment is displayed across the entire length of the Timeline. In the same manner, you can 

zoom out for a broader perspective, so that the entire duration of the linked video is displayed 

in the Timeline. 

 

 
 

The drop-down menu enables you to either choose a predefined value or insert a value 

between 1 and 100 manually. Alternatively, the zoom level can also be adjusted using the key 

combination [CTRL] + [Number] – from 100% ([CTRL] + [1]) to 2% ([CTRL] + [9]). 

 

Clicking on the plus and minus buttons allows you to zoom in or out in ascending or descending 

increments. Alternatively, you can use [CTRL] + [-] to zoom out and [CTRL] + [+] to zoom in. 

Clicking the button  will reset the displayed area back to 100%. 

 

Tip: Should you find that annotations are not being displayed properly in the Timeline View, 

you can try to change the zoom level, which will restart the Timeline. The Timeline can also be 

reloaded by right-clicking on “Timeline” (a tab which can be found on the left side above the 

Timeline View). 
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1.2.5. Limit display to the current area 

If you right-click on “Timeline” (the tab on the top left of the Timeline View) and select “Limit 

display to current area”, the area displayed in the Timeline will be limited to the current 

(zoomed in) selection. 

 

 
 

The current zoom level – in our example, 5% – will then turn to the new 100%. Following this 

method will allow you to zoom in much more than the original 1% of the linked video file. 

 

 

 

This feature is also useful in delineating a segment for critical analysis – for example, when 

you wish to make annotations for a single scene out of a film. 

 

By using the option “Display whole movie”, you can revert back to displaying the linked video 

on the Timeline in its entirety. 
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1.2.6. Displaying the entire video file (Display whole movie) 

If the area displayed in the Timeline has been limited to only a portion of the linked video by 

using “Limit display to current area”, this limitation can be reverted by right-clicking on 

“Timeline” (the tab on the top left of the Timeline View) and selecting the option “Display whole 

movie”. 

 

 
 

The entire linked video should now be once again visible in the Timeline. 

 

1.2.7. Saving and loading a Timeline View 

If you want to save a Timeline View – this means the Selection and ordering of annotation 

types, the Zoom level and the Displayed area, right-click on “Timeline” (the tab on the top left 

of the Timeline View) and choose the option “Save view”. 

 

 
 

A window will open that requires you to enter a name and ID for the specific Timeline. 

 

 
 

T 

  



 

24 
 
 

he view modes can be loaded and managed from the Package Finder, by going into the “View” 

menu and selecting the option “Package finder”. All Timeline Views are listed under “List of 

views” and “Adhoc views”. This is also where you can select the desired Timeline View when 

opening a package, should it not be displayed already. 

 

 
 

Note: If you are using the AdA Template, you can already access the AdA Corpus Analysis 

View (under “Adhoc views” in the Package Finder), which consists of a ready-made basic set 

of annotation types. 

 

Similarly, you can open saved Timeline Views when opening a new Timeline. To open a new 

Timeline, drag the Timeline icon from the toolbar onto a Workspace.  
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1.3. Table View 

The Table View displays annotations of a certain annotation type in the form of a table, which 

provides a quick overview of the existing annotations for one track. This allows you to quickly 

and easily edit annotation values – but not the annotation boundaries. Additionally, this view 

mode allows you to sort the annotations, for example, by duration or by value. 

 

 
 

To open the Table View, drag the Table icon from the toolbar onto a Workspace; after doing 

so, select the desired annotation type for which you want to open the Table View. 

 

 
 

Alternatively, the Table View can be opened by right-clicking on the desired annotation type in 

the Timeline View and selecting the option “Display annotations in table”. 
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In addition, annotation types, but also a selection of annotations, can be moved to a workspace 

by dragging-and-dropping. When doing so, a window will pop up on the screen; select the 

option “in a table” to open the Table View. 

 

 
 

Editing and sorting values in the Table View basically works the same way it does in a word 

processing program. If you click on one of the columns, the table will be rearranged based on the 

respective category, for example alphabetically (by content) or in the chronological order of their 

start time. 

 
 

You can select an individual annotation by clicking on one of the snapshots (preview images); 

this will highlight it in orange. 

 

To edit the content of an annotation, press [enter] or click on the displayed content, which will 

open the text input field. You can press [enter] again to close the text input field and jump 

automatically to the next annotation in the Table View. This one can now be edited following 

the same procedure. 

 

Additionally, you can use the arrow keys [up] and [down] to navigate the Table View. 
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If you press the [space] key, the video player will jump to the starting point of the selected 

annotation (highlighted in orange); you can use the video player controls (through the shortcuts 

in Video player controls) without leaving the Table View. 

 

Note: By right-clicking “Annotation table view” and choosing the option “Export as CSV”, you 

can export the table contents as a CSV file. 

 

1.4. Transcription View 

In the Transcription View, all annotations of a certain annotation type are displayed in 

consecutive order as a flowing text. Each line renders the content of a single annotation. This 

view mode is especially useful in allowing you to maintain an overview when annotating large 

amounts of text, and is therefore especially helpful when transcribing spoken word content or 

manually correcting subtitles. 

 

 
 

To open the Transcription View, drag the Transcription icon from the toolbar onto a Workspace; 

afterwards, select the desired annotation type for which you wish to open the Transcription 

View. 
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Alternatively, the Transcription View can be opened by right-clicking on the desired annotation 

type in the Timeline View and selecting “Display as transcription”. 

 

 
 

The Transcription View lends itself well for verifying and editing existing annotations; creating 

new annotations or modifying annotation boundaries is not possible in this view mode. 

 

Each annotation is displayed as a single line. The annotation corresponding to the current 

timecode in the video player is always displayed in bold font. This allows you, for instance, to 

read dialogue alongside the video playback, and review not only the content of an annotation, 

but also annotation boundaries. To edit a specific annotation, simply click on the desired area. 

 

 
 

Clicking on the green arrow allows you to switch between various preset display options, for 

example in order to display start and end times alongside annotations, or to display the 

annotations as flowing, continuous text (as opposed to separate lines of text). If you click on 

the tool symbol (top right in the Transcription View), you can specify the desired representation 

mode and set it as “Default representation”. 
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To save changes you make to annotations in this view mode, click on the green check mark. 

 

 
 

 

Exporting as text document 

The content of the displayed annotation type can be exported as a text document by clicking 

on the download symbol (top left of the Transcription View). 

 

 
 

1.5. Package Finder 

The Package Finder is displayed when opening a new package (this occurs usually on the 

right side of the video player). To manually open the Package Finder, drag the corresponding 

symbol from the toolbar onto a Workspace. 

 

 
 

Alternatively, the Package Finder can also be opened by going into the “View” menu and 

selecting “Package finder”. 

 

 
 

Note: If you open a package and not all view modes are displayed, open the Package Finder 

again manually in order to restore all data contained in the package. 
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On the left column of the Package Finder, you can find the package name in the top line. 

Clicking on the package name will open up a list of the various statistical details pertaining to 

the data contained in the package; this includes, among others, the total number of annotation 

types and annotations it contains. 

 

 
 

If you click on “List of schema elements”, you can get an overview of each schema contained 

in the package, the corresponding annotation types, as well as their subordinate annotations. 

You can move from one level to the next by choosing a schema or an annotation type, 

respectively. For instance, you can use this method to click your way from the schema “Image 

Composition”, through the annotation type “Field Size”, to the annotation “medium shot”. 

 

Note: A schema can combine multiple annotation types, for example all annotation types that 

describe language or image composition. 

 

Note: The AdA Template already provides various pre-made annotation levels saved as 

schemata, as well as the annotation types they contain. 

 

 
 

You can compile new schemata by right-clicking the column “List of schema elements”. 
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Similarly to the Timeline View, right-clicking on an annotation type allows you to perform 

various actions. 

 

Tip: Annotation types with a lot of corresponding annotations are most easily deleted in the 

Package Finder. If you need to delete an annotation type, for example, in the Timeline View, 

all annotations are displayed on screen in the next step, which can be more time-consuming if 

there is a large number of annotations. Since this graphic representation process does not 

happen in the Package Finder, this is a considerably more time-efficient solution. 

 

It is possible for annotation types to still appear in the Package Finder after being deleted. This 

error can be remedied if you select a different schema and then return to your current one. 

 

 
 

All views and view modes included in the package are listed under “List of views”. 

 

In addition, you can see all Caption Dynamic Views pertaining to individual annotation types 

under “Dynamic views”. 
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“Adhoc views” contains all saved view modes for the Timeline. 

 

Note: In the AdA Template, this is also where you can find the AdA Corpus Analysis View. 

 

 
 

1.6. Note-taking Editor 

The Note-taking Editor allows you to easily transcribe larger amounts of text and arrange 

timecodes in the video player based on the position of the timestamps. The text content here 

is not automatically synchronized with other view modes, but it can be converted into 

annotations. For this reason, the feature lends itself best for writing down longer pieces of text, 

which can afterwards be edited in a different step in order to fine-tune annotation boundaries. 

 

 
 

To open the Note-taking Editor, drag the Note-taking icon from the toolbar onto a Workspace. 

 

 
 

Alternatively, you can also access the Note-taking Editor by opening the “View” menu and 

selecting the option “Note taking”. 
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This will open up a window into which you can type text. Double-click in order to insert a 

timestamp at the desired position corresponding to the current timecode in the video player. 

You can also do this by using the key combination [CTRL] + [enter]. Click on a timestamp and 

the video player will jump to the assigned timecode. If converting at a later point, the text 

between two timestamps corresponds to the content value of an annotation. The annotation 

boundaries are likewise aligned to the timestamps. 

 

Tip: Using the key combination [CTRL] + [space] can make it easier for you to stop or resume 

playback in the video player. 

 

 
 

If the clock icon is active: once you resume typing after a pause, a new timestamp will be 

inserted automatically before this new text. This feature can massively speed up the 

transcription process. 

 

 
 

If the orange, downward-pointing arrow is active, all segments positioned earlier than the 

current timecode in the video player will be displayed with a gray background. From the 

segment corresponding to the current video player timecode onwards, the text will have a clear 

background. This allows you to easily keep track of which timecode corresponds to which 

segment in the Note-taking Editor. 
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It is possible to use a timestamp for marking not only (as in the example above) the beginning 

of an entry (which will then have an automatic boundary because of the timestamp that starts 

the next entry), but also (as in the example below) for marking the end of an entry. This 

automatically produces an “empty“ segment without text, which will be converted into an empty 

annotation. If you don’t want this kind of annotation to be created, you can deselect the option 

“Generate annotations for empty contents” when converting. 

 

 
 

Warning: Entries and changes made in the Note-taking Editor are not automatically 

synchronized with other view modes (as is the case, for example, with the Transcription View). 

The annotations always have to be converted when switching to or switching from the Note-

taking Editor. 

 

Clicking on the cogwheel symbol allows you to convert annotations based on existing 

annotation types inside the Note-taking Editor, which will turn them into text with timestamps. 

 

 
 

Clicking on the symbol highlighted below allows texts from the Note-taking Editor to be 

converted into annotations. 
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Annotations can be added to any available annotation type. Additionally, before adding the 

new annotations, you can select whether the existing annotations already assigned to a 

specific annotation type should be kept or deleted. To do this, check or uncheck the box 

marked “Delete existing annotations in this type”. 

 

Alternatively, you can also create a new type for the annotations produced in the Note-taking 

Editor by choosing “Create a new annotation type”. 

 

 
 

After the annotations have been converted, you can, for instance, display them in the Timeline 

View and edit them further. 

 

 
Both save icons allow you to save the entries made in the Note-taking Editor as .txt files. 

 

 
 

Clicking the file icon allows you to open a text file in the Note-taking Editor – for example, a 

previously created and saved file from the Note-taking Editor – and continue to edit it or convert 

it into annotations. 
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1.7. Edit View (for individual annotations) 

To open the Edit View for an individual annotation, right-click on the desired annotation in the 

Timeline View, choose the first line in the pop-up menu (this will display the text content of the 

annotation) and then select the option “Edit”. 

 

Note: There is also an Edit View for annotation types. You can use it to adjust settings for 

individual types. 

 

 

 

The Edit View allows you to edit the start time, the end time, and the content of annotation. 

 

 
 

  



 

37 
 
 

You can either manually type in the times or click on the  symbol next to the value entry 

field in order to align them with the current timecode in the video player. You can adjust the 

timecode by using the arrow buttons: either by one second (the double arrows), or one tenth 

of a second (the single arrows). 

 

 
 

You can enter the content of the annotation in the input field below. The first time you press 

[enter], the next line will display the number 2, and so on. In order to prevent problems with 

rendering and analyzing annotation values, we advise you to type in the entire content of an 

annotation without pressing [enter]. 

 

Above this input field you can see the MIME-Type to which the entire annotation type has been 

assigned. 

 

 
 

Right-clicking on the green check mark on the right side will save all changes made to the 

annotation. Clicking on the green check mark on the left will also save these changes, but 

close the Edit View as well. Clicking on one of the two orange arrow symbols will either jump 

to the Edit View for the previous or the next annotation in this annotation type. 
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2. Preferences 

Before starting the annotation process, you should review and/ or adjust the basic settings by 

opening the “Edit” menu and selecting “Preferences”. 

 

 
 

In the following paragraphs, we will briefly introduce the individual sections of “Preferences”, 

as well as selected relevant settings. 

 

 
 

2.1. Paths 

In “Paths”, you can choose to save the image cache for snapshots (preview images) either in 

a temporary folder or in another local folder, so that you can continue to use the snapshots the 

next time you open the project. 
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2.2. GUI 

In the “GUI“ tab, you can check the “Expert mode” box in order to have access to all settings 

and functions available in Advene. 

 

 
 

2.3. General 

If you check the “Use UUIDs” box in the “General” tab, every annotation will be assigned an 

UUID (universally unique identifier). This simplifies editing and searching for annotations 

belonging to several packages. We recommend always having this option active, since there 

are no disadvantages to doing so. 

 

Additionally, it makes sense to select “is done automatically” for “Auto-save”, so that at every 

set interval (“Auto-save interval (in s)”) an automatic backup of the package in its current 

version is created. 
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2.4. Workspace 

In “Workspace” you can select an option that makes the program save the current workspace 

(the arrangement and visual setup of the video player, the Timeline View, and other view 

modes) automatically whenever you save the package, so that the workspace will also be 

directly loaded the next time you open the package. 

 

 
 

2.5. Video Player 

Under “Video player”, the “Video output” should be set to “Gtk”. This setting works for most 

systems. 

 

Tip: If you encounter problems with video playback, we recommend trying out the other 

formats offered under “Video output”. To ensure that such problems are not related to the video 

file itself, you should test to see if the file can be played in other video players, such as VLC 

media player. 
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2.6. Time-related 

In the “Time-related” tab, you can adjust the “Default FPS” (frames per second) of the linked 

video, so that shot boundaries are correctly and consistently displayed. 

 

 
 

Note: Setting up “time increments” is explained in more detail in the section Video player 

controls. 

 

2.7. Timeline parameter 

In “Timeline parameters” you can adjust “Font size”, annotation and annotation type height 

(“Button height”), as well as the distances between tracks (“Interline height”) in the Timeline 

View; this can help you optimize them for your screen size and/ or resolution, in case the 

standard settings are hard to read or overlap each other. 
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2.8. Text content 

Under “Text-content” you can select the following options: “Completion mode”, “Predefined 

terms only”, and “Quick fill”. 

 

 
 

Completion mode 

“Completion mode” activates an automatic completion that has access to all previously 

annotated texts and offers suggestions for automatic text completion. 

 

Predefined terms only 

“Predefined terms only” activates an auto-complete mode that only suggests values that have 

been marked as “Completions” for the specific annotation type. 

 

Quick fill 

“Quick fill” makes it possible for you to assign values to an annotation (values pertaining to an 

annotation type that have been previously marked as “Completions”) by using the number keys 

on your keyboard. If an annotation is selected (for instance with the mouse pointer) – you can 

recognize this because it will be displayed inside a thicker frame – you can press the 

corresponding number keys to fill the entry with the desired value. Pressing the same number 

key again removes the value you just added. 
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3. Creating and editing a package 

Advene works with packages that are saved as files with an .azp suffix (.xml and .apl are also 

possible). We describe below how you can work with one or several packages, respectively. 

 

3.1. Opening and closing a package 
 

Opening a package 

To open a package, go to the “File” menu and select “Open package”. 

 

 
 

Select the desired package in the window that opens up on the screen. 

 

The most recently used packages can also be accessed by going into the “File” menu and 

selecting “Open recent”. The last ten opened packages will be displayed there. 

 

 
 

Closing a package 

In order to close a package, go into the “File” menu and select “Close package”. 

 

 
 

Note: You can open multiple packages in parallel and switch between packages. Selecting 

“Close package” will always close the currently loaded package. 

 

When you close Advene, all open packages will also be closed, and you may be asked whether 

you wish to save changes made to any of the packages. 
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3.2. Creating and saving a package 

Creating a new package 

When you open Advene, the program will always automatically load a new, empty package. If 

you do not need to open an existing package, you can annotate directly in this empty package. 

To save this package, go into the “File” menu and select “Save package as…”. 

 

 
 

A window will pop open where you can enter a name and save location for the package; confirm 

your selection with “Save”. 

 

 
 

When you close the package or close Advene, this same window will pop up to ask you if you 

wish to save the package, select a name for it and a save location. 

 

Note: To annotate using the AdA Routine, you can download and use the corresponding AdA 

Template. 
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Saving changes made to an existing package 

To save changes made to an existing package, go to the “File” menu and select “Save package 

[CTRL-S]”. 

 

You can also do this by using the key combination [CTRL] + [s]. 

 

 
 

If you want to save the changes under a new package, go to the “File” menu and select “Save 

package as…”. This option helps you preserve the original file whenever you make changes. 

 

Working with multiple packages in parallel 

Advene allows you to have multiple packages open at the same time. In the “Packages” menu, 

you can find a list of all currently open packages. This allows you to switch from one currently 

displayed and editable package to another open package in order to edit it. 

 

 
 

If a package is already open, you can go to the “File” menu and select “New package” to create 

a new additional package. 
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3.3. Importing a package 

If you want to import one package into another, select “Import package” in the “File” menu. 

 

 
 

Select the desired package to import in the pop-up window. 

 

You can now assign a suffix in the “Package importer view” – for example, “IMPORTED” – that 

will be added to the names of all selected and subsequently imported annotation types. 

 

 
 

You can use the mouse click to select which annotation types should be imported. For 

orientation purposes, the number added at the end of annotation types in brackets is the 

number of existing annotations on the respective tracks. This helps you rule out empty 

annotation types when importing. 
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The button “All” allows you to select all annotation types. The button “None” allows you to 

deselect all annotation types. You can confirm your selection by pressing “OK”, which will 

import the selected annotation types into the current package. 

 

Tip: If you hold down the [SHIFT] key, you can select multiple consecutive elements; once you 

click on “Selection”, these will also be added to your current selection. If you hold down the 

[CTRL] key, you can select multiple disparate elements; clicking on “Selection” will also add 

these to your current selection. 

 

The imported annotation types are now available in the current package and can be displayed, 

for instance, in the Timeline View. 

 

 
 

This function can be useful when you want to compare various annotations created for the 

same video with each other. 

 

Tip: Other file formats can be imported into an existing package by using the “Import File” 

feature. 

 

3.4. Merging packages 

Annotations contained in multiple packages, e.g. separately annotated scenes from a film, can 

be merged seamlessly into one package. Once the merging has been completed, not only are 

all annotations contained in one package, but all annotations assigned to the same annotation 

type are displayed in the same track. 

 

Tip: If you want to merge multiple packages together, but keep the annotations in separate 

annotation types, for example in order to compare annotations, use the “Import package” 

feature. 
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Open a package to use as a starting point, for example the one with the highest number of 

relevant annotations, then select “Merge packages” from the “File” menu. 

 

 
 

A window will pop up onto the screen; select which package should be merged with the current 

package. 

 

In the following step, another window will appear; this allows you to choose the package 

elements that you want to add to the current package. 

 

 
 

You can select the elements you wish to import by simply clicking on them. “Create element“, 

for example, allows you to add annotations or annotation types from the package you are 

importing and have them created in the current package. “Update …” will transfer the 

properties or metadata of the entries in the package you want to import to those in the curre 

package. 

 

Note: Each annotation in the package you are importing will be listed individually. “Element” 

will display the name of each specific annotation, while “Type” will do the same for annotation 

types to which the annotation has been attributed. 
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In order to add all annotations, or a selection of desired annotations from one annotation type 

to the current package, you need to select both the annotations, as well as the annotation type. 

If the same annotation type already exists in the current package (this is for instance the case 

when both packages are based on the same template), it is enough to only select the desired 

annotations from this track. 

 

The button “All” selects all elements. The button “None” deselects all elements. Press “OK” to 

confirm your selection and import the desired elements into the current file. The Timeline will 

now update itself with the newly added data. 

 

Tip: If you hold down the [SHIFT] key, you can select multiple consecutive elements; once you 

click on “Selection”, these will also be added to your current selection. If you hold down the 

[CTRL] key, you can select multiple disparate elements; clicking on “Selection” will also add 

these to your current selection. 

 

Note: You can also use this method to add a template to an existing package. By doing this 

you can, for example, import the AdA Template into a package in order to enable html-

visualization. To do so, choose all elements from the AdA Template and add them to the 

desired package. Such visualizations can also be added individually to an existing package as 

“Views”, as in the example below. 
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3.5. Splitting a package 

By using the “Split according to annotations” function, you can create multiple new packages 

out of an existing one. The start and end points for the new packages are based on the 

annotation boundaries of those annotations included in the selected annotation type. The base 

package is, so to say, divided based on the annotation boundaries. To split a package, go to 

Timeline View, right-click the annotation type on which you want to base the splitting into 

packages, and select “Split according to annotations”. 
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4. Linking a video file 

Before you can begin work in Advene, you have to link the video you wish to annotate and 

adjust the settings for its corresponding video file. 

 

Associate a video file 

To link a video file, go to the “File” menu, click on “Associate a video file”, and select a 

compatible video file in the window that opens up. 

 

 
 

You can alternatively choose a video file by clicking the video icon in the toolbar. 

 

 
 

Note: After linking a video file, you should always check the video framerate and, if necessary, 

adjust it in “Preferences” accordingly. 
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Checking the video frame rate 

Before you start creating annotations, you should always check that the framerate of the linked 

video is the same as the framerate set in “Preferences”. To do so, go to the “Player” menu and 

select “Display Media information”. The framerate will be listed in the window that pops up, 

along with other video properties. 

 

 
 

Adjusting framerate accordingly in “Preferences” 

Open “Preferences” in the “Edit” menu. Under the “Time-related” tab, check the framerate and, 

if necessary, adjust it in the “Default FPS” drop-down menu to the same framerate as the linked 

video. 

 

 
 

Note: We recommend you use this method to check whether the Advene “Default FPS” 

matches the framerate of the linked video every time you start the program. This is especially 

useful when alternating between different packages linked to different video files. 
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Recommendations for video files 

To avoid potential video playback issues, we will list below a few recommendations for the 

technical specs your video files should have. 

 

The ideal format for video files is .mp4 (videocodec: H.264 and audiocodec: AAC). 

 

The framerate should match that of the original, since movement effects and duration can be 

altered by a different framerate. A constant framerate is preferable to a dynamic framerate. 

Common framerates are 24, 25, 29.97, or 30 fps. 

 

Similarly, the DVD or Blu-Ray resolution should be preserved (picture width: 480p and 1080p, 

respectively). We recommend you avoid anamorphic picture formats. If cropping is necessary, 

you have to maintain the aspect ratio. 

 

If available, deinterlacing should be balanced out when transcoding, for instance with 

“Decomb”. 

 

For decent sound quality, we recommend a bit rate of at least 192 Kbit/s. 

 

If you are using it on a computer equipped with sufficient processing power, Advene can also 

handle large video files. For this reason, you should rather try not to use files that have been 

compressed too much. By this metric, a file size of less than 500 MB for a 90-minute film is 

rather unusual. 
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5. The annotation process 

Annotating is the central component of working with Advene. While doing so, you create 

annotations: individual segments of a linked video assigned to an annotation type and filled 

with values. 

 

 
 

Annotation types characterize specific descriptive dimensions of audiovisual media, such as 

the camera perspective or the music mood. In Advene, annotation types can be graphically 

rendered as individual tracks (among other possibilities), as is the case with the Timeline View. 

Annotations are time-limited single units, which can refer, for instance, to different shots or 

scenes; they are all assigned to an annotation type. Their content describes, on the level of 

their respective annotation types, a fixed time segment of the selected video (for example a 

low-angle shot on the camera angle level, or a sad piece of music). 

 

There are various possibilities and view modes for entering annotation values, which are 

designed to make your work easier for each particular annotation type. For some annotation 

types, it also makes sense to prepare a selection of previously defined values, while others 

can be filled with individually formulated plain text. In addition, it is possible to generate 

annotations automatically for some annotation types. 

 

We will use the following paragraphs to explain how you can work with annotations and 

annotation types in more detail. 

 

5.1. Creating and editing annotation types 

In Advene, annotations are always assigned to an annotation type, which means a descriptive 

dimension to which they refer. For example, the annotation of a medium long shot refers to the 

field size annotation type. Annotation types can be rendered visually as tracks in the Timeline 

View, which can then be populated with annotations for individual segments of the video. 

Annotations can also be rendered in other view modes, such as the Table View or the 

Transcription View, in order to allow you to edit annotations. 
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5.1.1. Creating a new annotation type 

You can create a new annotation type by clicking on the plus symbol on the left side of the 

currently displayed annotation types in the Timeline View. 

 

Tip: If the Timeline already displays several annotation types, you will have to scroll to the very 

bottom. The plus symbol will usually be positioned under the last track. If the symbol is not 

visible, you can hide all currently displayed annotation types in order to make the plus symbol 

visible (by using “Displayed annotation types”). 

 

 
 

After clicking the plus symbol, a window will open up where you can assign a name, an ID, 

and a MIME-Type for the annotation type. In addition, you can assign it to a specific schema. 

 

 
 

Assigning a Name and an ID 

Advene automatically generates a name and ID; we recommend, however, that you give your 

annotation types descriptive names that makes them easy to recognize later. The name and 

ID can be identical. 

 

Warning: Once you create an annotation type, it is no longer possible to change its ID. 

 

Assigning a MIME-Type 

In this window, you can additionally configure in what manner the annotations on this track 

should be filled by assigning a MIME-Type (content type). 
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Plain text content 

If you want to fill the annotations with plain text, select the “Plain text content” MIME-Type. 

 

 
 

This MIME-Type lends itself, for example, to annotating spoken language. 

 

Keyword list 

If you want the values that can be assigned to annotations in this annotation type to be limited 

to certain specific terms, use the “Keyword list” MIME-Type. The desired values can be 

specified in the Edit View for the specific annotation type ("Completions"). 

 

 
 

This MIME-Type can be useful for annotation types in which frequently recurring concepts are 

being used for annotations, for example field size or camera angle. 

 

List of numeric values 

For some annotation types, the annotated values are available as numerical values; they can 

be graphically rendered in the Timeline View as waveforms. This is the case, for instance, with 

the automatically generated Sound enveloppe, but also other imported data. For such tracks, 

you should select the MIME-Type “List of numeric values”. 
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Assigning annotation types to a schema 

The newly created annotation type can be assigned to a schema. Multiple annotation types 

can be bundled into one schema, which can describe, for example, language or image 

composition. 

Note: When using the AdA Template, the levels of the AdA Filmontology are already collected 

into schemata, as illustrated by the example below. 
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If you have an annotation type you do not want to assign to an existing schema, you can create 

a new one of your own by choosing “Create a new schema”. The newly created annotation 

type will then be automatically assigned to this schema. 

 

 
 

Just like when creating an annotation type, you can set a name and ID for the newly created 

schema as well. We recommend using a descriptive name that is easily recognizable; if you 

do so, the name and ID can be identical. 

 

Warning: You also cannot change the ID of a schema once it has been created. 
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5.1.2. Editing annotation types in the Edit View 

Any property of an annotation type – with the exception of the ID – can still be modified after 

creating it. To do so, right-click on the desired track in the Timeline View, select the name of 

the annotation type in the top row, and click on “Edit”. 

 

 
 

The Edit View for this annotation type will open into a Workspace (normally, on the right side 

of the video player). 

 

 
 

Modifying the name 

Under “Title (name)”, you can edit the name of the annotation type. 
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Checking metadata 

The drop-down menu “Metadata” allows you to check the annotation type ID, but as previously 

mentioned you cannot change this ID once created. 

 

 
 

Note: The ID is useful, for example, when customizing the AdA Timeline. 

 

Changing the MIME-Type 

You can change the MIME-Type assigned to an annotation type under “MIME Type”. 

 

(For an overview of common MIME-Types, see: Assigning a MIME-Type) 

 

 
 

Adding a description 

Under “Description”, you can add a description of the annotation type. 

 

Note: In the AdA Template, this is where the corresponding definitions from the AdA Ontology 

are listed. 
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Changing annotation type colors 

Under “Color”, you can select the color used to display the name of the annotation type in the 

Timeline View. The desired color can be entered either as a color code or by clicking on the 

color rectangle. 

 

 
 

Changing annotation colors 

By default, annotations are given the same colors as their annotation types. In the drop-down 

menu “Advanced” you can set the color of individual annotations based on the annotated value 

by selecting “Item color”. This is particularly relevant for tracks on which annotation values are 

limited to specific terms (“Keyword list”). If you assign a distinct color to each term, you can 

achieve a good color-oriented overview when visualizing the Timeline that will show you the 

proportions and disposition of values throughout the video. 

In order to link a value to a specific color, the following logic applies: 

 

python:('COLOR1' if here.content.data=='VALUE1' else ('COLOR2' if 

here.content.data=='VALUE2' else 'COLORofTRACK')) 

 

Warning: Remember to always close open brackets at the end. 

 

Example from the AdA Template 

In the AdA Template, the color classification for the annotation type ImCo | Image Brightness 

looks like this: 

 

 
 

The complete order is as follows: 

 

python:('white' if here.content.data=='bright' else ('grey' if here.content.data=='medium' else 

('#404040' if here.content.data=='dark' else ('lightgrey' if here.content.data=='bright-dark' else 

'lightgreen')))) 
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The allocation of values to colors behind this order: 

 

Value Color 

bright white 

medium grey 

dark #404040 

bright-dark lightgrey 

no value or other value lightgreen (annotation type color) 

 

The corresponding annotations in the Timeline View look like this: 

 

 
 

Specifying completions 

If the MIME-Type is set to “Keyword list”, you can enter values allowed for annotations on this 

track under “Completions” in the “Advanced” drop-down menu. Enter the individual values, 

separated by commas but without spaces, one after the other. 

 

 
 

If the option “Quick fill” is activated (in “Preferences”, under “Text content”), the values entered 

under “Completions” will be assigned corresponding number keys (beginning with 1). The 

values can then be added to an annotation directly by pressing the number keys, as soon as 

any annotation has been selected (for instance, with the mouse pointer). 

 

Value Number Key 

value01 1 

value02 2 

value03 3 

 

Note: In the AdA Template, all suitable annotation types have been assigned values from the 

AdA Ontology and can be used with Quick fill. 
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5.1.3. Deleting an annotation type 

To delete an annotation type and all the annotations it contains, right-click on the desired track 

in the Timeline View, then select the name of the annotation type in the top row and select the 

option “Delete”. 

 

 
 

Warning: You cannot undo the deletion of annotation types. 

 

Tip: Annotation types that contain a lot of annotations can be most easily deleted through the 

Package Finder, since in this view mode the annotations are not graphically rendered, unlike 

in the Timeline View. 
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5.1.4. Copying an annotation type ID 

To copy the ID of an annotation type to the clipboard, right-click on the desired track in the 

Timeline View and select the option “Copy id (…)”. 

 

Note: The ID will be required, for instance, when customizing the AdA Timeline. 

 

 
 

5.1.5. Copying all annotations from an annotation type 

In order to copy all annotations from an annotation type, go to the Timeline View; drag the 

annotation type containing them onto a different one. A window will pop up on the screen. 

Select “Duplicate all annotations to type (…)”. 
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5.1.6. Moving all annotations from an annotation type 

To move all annotations from an annotation type into another one, open the Timeline View. 

Drag the annotation type containing the annotations you want to move onto another one. A 

window will open up; select “Move all annotations to type (…)”. 

 

 
 

5.1.7. Searching and replacing content 

If you want to replace a term in all annotations that contain it with a different one, we 

recommend the “Search/replace content” feature. To do so, open the Timeline View. Right-

click on the desired track, then select the annotation name in the top row and “Search/replace 

content”. 
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A window will pop up and offer the typical search/ replace functionality. 

 

 
 

This feature allows you to replace a value with a different one in an uncomplicated way; for 

example, to replace an obsolete description in all annotations belonging to an annotation type 

with a newly formulated value. 

 

A value can also be removed from all annotations that contain it. To do so, leave the “Replace 

by” field blank. 

 

Similarly, you can delete the entire content of all annotations on the selected track. To do so, 

leave both the search and the replace fields blank. The empty annotations are not deleted in 

this process and can be filled with new content. This can be useful, for instance, when you 

want to import the annotation segmentation from a different annotation type, but without 

carrying over their content. 
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5.1.8. Specifying an offset for all annotations in an annotation type 

If you notice that all annotations in an annotation type consistently start too early or too late, 

you can specify an “Offset” for this track. To do so, right-click on an annotation type, then on 

the name of the track in the top row and select the “Offset” option. 

 

 
 

In the window that pops up you can specify an “Offset” so that all annotations on this track are 

pushed forward or backward. The “Offset” can be entered in milliseconds; if the framerate is 

25 fps, this results in an offset of 40 ms per frame. Entering a positive value will shift all 

annotations on the Timeline to the right, which is to say forward in time. If there is a minus sign 

before the set value, annotations will be pushed to the left, which is to say backward in time. 

 

 
 

Tip: This feature can be useful, for example, to adjust the timing of subtitles after importing 

them. 
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5.1.9. Deleting all annotations in an annotation type 

To delete all annotations in an annotation type, right-click in the Timeline View on the desired 

track and select the option “Delete all annotations”. 

 

 
 

Tip: You can also delete all annotations on a track in the Package Finder. To do this, right-

click on the desired annotation type and choose “Delete all annotations”. 

 

5.1.10. Renumbering annotations 

To renumber all annotations in an annotation type, go to the Timeline View, right-click on the 

desired track and choose the “Renumber annotations…” option. 
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In the window that opens up, you can set an “Offset” from which the new numbering should 

begin. 

 

 
 

Warning: If you make changes to the annotation type in question or to the annotations it 

contains – for example, deleting some of the annotations – you should renumber the track, 

because the numbering will not automatically update to reflect the changes. 

 

5.1.11. Splitting a package (according to annotations) 

By using the “Split according to annotations” function, you can create multiple new packages 

out of an existing one. The start and end points for the new packages are based on the 

annotation boundaries of those annotations included in the selected annotation type. The base 

package is, so to say, divided based on the annotation boundaries. If you use this, for example, 

on a track where the scenes of a movie have been annotated, a package will be created for 

each scene, based on the annotated scene boundaries. The annotations that are contained in 

any annotation types of the initial file will also be distributed into the newly created packages. 

 

To split a package, go to Timeline View, right-click the annotation type on which you want to 

base the splitting into packages, and select “Split according to annotations”. 
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The individual new packages will be created in the same folder containing the base file. The 

file names for these new packages will consist of the base file name, the additional “split”, an 

order number, as well as the content of individual annotations. 

 

 
 

This feature can be useful, for instance, when you want to annotate a film based on its division 

into scenes; you can then split it into individual scene packages, so that the annotation process 

can be divided between multiple people. 

 

Tip: You can recombine individual packages, for example after multiple people have made 

annotations for them, by using the “Merge packages” feature. 
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5.2. Creating and editing annotations 

Annotations are time-limited single units assigned to an annotation type. Their content 

describes, on the level of their respective annotation types, a defined segment of the selected 

video stretched over the time duration of the annotation. 

 

5.2.1. Creating annotations (New annotation at(…)) 

To create a new annotation, go to the desired start time in the video player. In the Timeline 

View, right-click on the desired track; select “New annotation at player time” in the window that 

opens up. 

 

 
 

Alternatively, you can use the “New annotation at mouse position” option to set the start time 

for the annotation based on the mouse pointer position (right-click). 

 

 
 

The length of an annotation and, thereby, its end time will be automatically generated and can 

be adjusted, for instance, through the “Split at current player position” or “Align end time to 

selected begin time” functions, as well as in the Edit View. 

 

Tip: If you hold down the [CTRL] key and click in the start or end area of an annotation, its 

start or end time will be aligned with the current timecode in the video player. 
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5.2.2. Deleting annotations 

To delete an annotation, go to the Timeline View and right-click on the desired annotation, then 

on the top line in the pop-up window (this will display the annotation content), and then choose 

the “Delete” option. 

 

 
 

Alternatively, you can also move the mouse pointer over the annotation you want to delete and 

then use the backspace key to delete it. 

 

Tip: You can undo deletions – except for deleted annotation types – by using the common 

shortcut [CTRL] + [z] or by going into the “Edit” menu and selecting the “Undo [Ctrl-Z]” option. 

 

5.2.3. Aligning annotation boundaries to other annotations (Align end/begin time to selected 

begin/end time) 

Annotation boundaries (the beginning and ending of an annotation) can be easily aligned to 

other annotations. To do this, select the annotation that needs to be aligned and drag and drop 

it onto the one to which you wish to align it. In the window that pops up, choose either “Align 

end time to selected begin time” or “Align begin time to selected end time”. This will close the 

gap between the two annotations. 

 

     
 

Tip: The annotation boundaries can also be adjusted by using the “Split at current player 

position” feature or in the Edit View. To match the start time or the end time to the current 

timecode in the video, hold down the [CTRL] key and click either in the starting or the ending 

area of an annotation. 
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5.2.4. Merging annotations (Merge with this annotation) 

To merge two annotations with one another, drag one of the two onto the other and choose 

“Merge with this annotation” in the window that opens up. 

 

 
 

The new annotation will have the start time of the first annotation and the end time of the 

second, based on their chronological order. 

 

 
 

Note: The new annotation will take over the content of the second annotation – the one onto 

which you dragged the first one. For example, if you merge an annotation with the content 

value “medium” to another annotation with the content “dark” and you do this by dragging the 

“dark” annotation onto the “medium” one, the new annotation content will be “medium”. 

 

5.2.5. Splitting an annotation (Split at current player position) 

To split one annotation into two, go to the Timeline View, right-click the desired annotation and 

select “Split at current player position” in the pop-up window. 

 

 
 

The split will always occur based on the current video player timecode, which is displayed in 

the Timeline View through a vertical blue line. To split an annotation at a precise point (for 

example, to mark the beginning of a new scene), navigate to the desired timecode in the video 

player and then perform the split. 

 

Note: Splitting an annotation will keep its content for both parts. 

 

Tip: You can also adjust annotation boundaries by using the “Align end time to selected begin 

time” or the “Align begin time to selected end time” functions, as well as within the Edit View. 
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To match the start or end time of an annotation to the current video player timecode, hold down 

the [CTRL] key and click in the starting or ending area of an annotation. 

 

5.2.6. Marking, copying, and moving a selection of annotations 

To mark a selection of annotations, go to the Timeline View, hold down the left click and draw 

a square with the mouse over the desired annotations. The selection can extend over several 

tracks. 

 

Warning: Only those annotations completely inside the boundaries of the square will be 

marked. 

 

 
 

When you release the mouse, the marked annotations will be highlighted yellow. 

 

 
 

The marked annotations can now be copied or moved to a different track. Alternatively, you 

can right-click the selection of annotations to open up a menu with further options. 

 

Copying a selection of annotations to a different annotation type (Duplicate selection to type 

(...)) 

Drag the marked annotations onto the annotation type where you wish to copy them; in the 

window that pops up, select “Duplicate selection to type (…)”. 
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The set of annotations is now available in both annotation types. 

 

 
 

Note: You can use the same method to copy individual annotations to other annotation types. 

In addition, you can copy all annotations contained within an annotation type by using the 

function “Duplicate all annotations to type (...)”. 

 

Moving a selection of annotations to a different annotation type (Move selection to type (...)) 

Drag and drop the marked annotations onto the annotation type to which you wish to move 

them; select “Move selection to type (…)” in the window that opens up. 

 

 
 

The selection of annotations will now only be available in the second annotation type. 

 

 
 

Note: You can use the same method to move individual annotations to other annotation types. 

In addition, you can also move all annotations contained within an annotation type to a different 

one by using the "Move all annotations to type (...)" function. 
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Further editing options for selections of annotations 

If you do not want to either copy or move the selection of annotations, right-clicking on any 

annotation in the selection will open up a menu with further options. 

 

 
 

If you choose the option “Select all annotations in this time range”, all annotations from all 

annotation types will be marked, provided they are linked to the same time interval as the 

selection of annotations. 

 

The “Delete selected annotations” option can be used to delete all marked annotations (as can 

the backspace key). 

 

Choosing “Center and zoom on selection” will limit and center the segment analysis area in 

the Timeline View to only include the marked annotations. 

 

The “Merge annotations” option allows you to merge the selected annotations into a single 

annotation. If you have selected annotations from several annotation types, all of them will be 

merged into one single annotation for every track. 

 

The “Extract video” option allows you to export a video file for the time segment within which 

the annotations are placed. 
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5.3. Adding annotation values 

The created annotations can be filled with content in various ways. We will briefly introduce 

the most common functions and view modes that allow this in the paragraph below. 

 

5.3.1. Quick edit 

Quick edit allows you to annotate directly in the Timeline View. If an annotation is selected (for 

example, using the mouse pointer) – you can recognize this by its thick borders – it can be 

opened up for editing by pressing the [enter] key. A text window opens up, which can either be 

filled with one of the values specified under "Completions", but also with plain text. Pressing 

[enter] a second time closes the text window and saves the changes you made to the 

annotation. 

 

 
 

Pressing [tab] will take you to the next annotation in the Timeline View. Pressing [space] will 

shift the video player to the beginning of the selected annotation, in order to play back the 

corresponding segment of the linked video. You can use the shortcut [CTRL] + [space] to start 

or stop the video playback. After watching it, you can once again open the annotation by 

pressing [enter], edit it, and close it again. 

 

5.3.2. Quick fill 

The Quick fill function allows you to annotate using the number keys; this can considerably 

speed up the annotation process. 

 

Warning: In order to be able to use this function, the “Quick fill” option must be activated in 

“Preferences” under “Text content”. 

 

If you have specified certain values as "Completions" for an annotation type, these will be 

automatically assigned to the number keys (beginning with 1). 

 

Value Number key 

value01 1 

value02 2 

value03 3 

 

You can now fill the annotations for this track by using the number keys. If an annotation is 

selected in the Timeline View (for example, by using the mouse pointer) – you can recognize 

this by its thick borders – you can press the corresponding number key to fill it with the desired 

value, without having to open the annotation for editing. Pressing the same number key again 
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will remove the added value. This also makes it possible to assign multiple different values to 

one annotation by using different number keys. 

 

You can press [tab] to jump to the next annotation in the Timeline View and fill this one as well 

by using the number keys. Pressing [space] will make the video player jump to the beginning 

of the selected annotation, in order to play back the corresponding segment of the linked video. 

You can use the shortcut [CTRL] + [space] to start or stop the video playback. 

 

Tip: Quick fill can also be used in the Table View, in order to fill a selected annotation 

(highlighted in orange) by pressing the number keys. After filling in one value, the Table View 

will automatically jump to the next annotation. If one annotation should be annotated with 

multiple values, you can use the [up] and [down] keys to navigate the table. 

 

Note: In the AdA Template, all annotation types have been assigned values from the AdA 

Ontology and can be used with Quick fill. Thanks to this, you can for instance assign the field 

sizes for the annotation type ImCo | Field Size by using the corresponding number keys. The 

number keys for each annotation type and value are listed in the AdA Filmontology. 

 

Example values Number 
key 

extreme_long_shot 1 

long_shot 2 

medium_long_shot 3 

medium_shot 4 

medium_closeup 5 

... ... 

 

  

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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5.3.3. The Edit View 

In the Edit View you can edit individual annotations. 

 

To open the Edit View, right-click in the Timeline View on the desired annotation, select the 

top line in the pop-up menu (this will display the annotation content) and select the “Edit” option. 

 

In the now open Edit View, you can edit both the start and end time of the annotation, as well 

as its content. Click on one of the green check marks to save all changes made to the 

annotation. 

 

(For a detailed overview of the Edit View, see: Edit View) 
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5.3.4. The Table View 

The Table View displays annotations for one annotation type in the form of a table, which can 

thus be sorted, for example, by duration or by value, but also edited. 

 

To open the Table View, right-click the desired annotation type in the Timeline View and select 

the “Display annotations in table” option. 

 

If you click on one of the snapshots (preview images), you can select a single annotation. This 

will be highlighted in orange. Pressing [enter] or clicking on the content opens the text input 

field, which allows you to edit the content of the annotation. Pressing [enter] again will close 

the text input field and automatically jump to the next annotation in the Table View. 

 

(For a detailed overview of the Table View, see: Table View) 
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5.3.5. The Transcription View 

In the Transcription View, all annotations of a certain annotation type are displayed in 

consecutive order as a flowing text. Each line renders the content of a single annotation. This 

view mode is especially useful in allowing you to maintain an overview when annotating large 

amounts of text – for example subtitles – and enabling you to verify and edit existing 

annotations. 

 

To open the Transcription View, right-click on the desired annotation type in the Timeline View 

and select the “Display as transcription” option. 

 

The annotation corresponding to the current timecode in the video player is always displayed 

in bold font. This allows you, for instance, to read dialogue alongside the video playback, and 

review not only the content of an annotation, but also annotation boundaries. To edit a specific 

annotation, simply click on the desired area. If you click the green check mark, changes you 

made to the annotations will be saved. 

 

(For a detailed overview of the Transcription View, see: Transcription View) 
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5.4. Automatically creating annotations (Process video) 

Some annotation types allow you to create annotations automatically by using the “Process 

video” function. We will briefly explain its most common uses below. 

 

5.4.1. Creating a volume waveform (Sound enveloppe) 

In order to create a waveform representing the volume for the linked video file, select “Process 

video” in the “File” menu. 

 

 
 

In the drop-down menu of the window that opens up, select “Sound enveloppe” and press 

“Start”. 

 

 
 

The options illustrated in the example below are considered standard. 

 

Warning: Advene does not automatically revert back to the default settings. It always applies 

the last used values for these settings. For this reason, we recommend taking the standard 

values shown below as a point of departure for each new project. 
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You can optimize your results by changing these parameters. For shorter formats, we 

recommend decreasing the “interval” value (measured in ms), which can lead to a higher 

resolution waveform. By increasing the “lower-db-limit” you can fade out background noise and 

make the oscillation of the curve considerably clearer. Setting too high a value for it can, 

however, cause certain passages (in spite of containing diverse ambient noise) to be displayed 

as silence and therefore mislead you. 

 

 
 

The generated annotations are displayed in the automatically generated annotation type 

“Sound enveloppe”. 

 

Note: If the automatically generated annotation type is not directly displayed in the Timeline 

View, you can select it by using the “Displayed annotation types” feature. 

 

 

 

Tip: You can easily copy or move annotations to a different track after they have been created. 
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5.4.2. Automatic Shot Segmentation (ShotdetectApp importer) 

To start an automatic shot segmentation process for the linked video file, go to the “File” menu 

and select the “Process video” option. 

 

 
 

In the window that pops up, select the “Filter” named “ShotdetectApp importer” from the drop-

down menu. 

 

 
 

Tip: If the “ShotdetectApp importer” is not working, you should check the “GUI” tab in 

“Preferences” to see if the application path is displayed correctly. 

 

Note: If the “ShotdetectApp importer” is not working or not available on the operating system 

you are using (for example Windows), you can use the filter “Scene change detection” to obtain 

similar results in most cases. However, since this filter does not allow you to adjust its settings, 

working with it may require more manual correction efforts in some cases (for example when 

dealing with more complex cutting patterns). 

 

Before you start the process, you should adjust the “sensitivity” as well as, if necessary, an 

“offset”. 
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Sensitivity 

“Sensitivity” adjusts how minutely Shotdetect scans the video. The lower you set this, the larger 

the frame-to-frame differences have to be in order for a cut to be detected. 

 

Tip: We recommend you to start running Shotdetect with an average value of 60. After this, 

you can decide if too many or too few shots have been detected. This means checking to see 

if Shotdetect has made annotations where the shot is not actually cut, or has missed too many 

cuts. In order to make a conclusive assessment, it makes sense to check simple areas, like 

for instance a shot reverse shot sequence, or more complex cutting patterns, like a rapidly cut 

montage sequence. If Shotdetect detects significantly too many or too few cuts, you can 

address this by adjusting the “sensitivity”. 

 

Warning: The “sensitivity” is increased when the value is decreased, for example from 60 to 

50. 

 

Offset 

Usually, it is not necessary to add an “offset”. However, if, for example, all the cuts detected 

with Shotdetect need to be shifted 2 frames forward, this error can be fixed for all annotations 

by adding an “offset”. The “offset” is defined in milliseconds. This means at, e.g., 25 fps, 40 ms 

per offset frame. A value higher than zero means that the annotations will be pushed to the 

right on the Timeline, which is to say to a later part of the video. If the value is lower than zero, 

the annotations will be pushed towards the left, which is to say to an earlier part of the video. 

 

Note: If you make such an adjustment, the start time for the first shot must be set to 00:00:00 

manually. 

 

Tip: The generated annotations can also be moved at a later point using a different “offset” 

function. 
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The new annotations will be displayed in the automatically generated annotation type Detected 

Shots. Each annotation will then represent a detected shot, and the annotation boundaries will 

match the detected cuts. 

 

Note: If the automatically generated annotation type is not directly displayed in the Timeline 

View, you can select it by using the “Displayed annotation types” ausgewählt werden. 

 

Tip: The more accurately Shotdetect is configured, the less you will have to manually correct 

the automatically generated annotations in the Shot Validation View. 

 

 
 

Tip: You can easily copy or move annotations to a different annotation type after they have 

been created. 

 

Note: Greater discrepancies between the detected shots and the actual existing cuts can have 

various causes. If too many cuts are detected, this can have various causes such as low image 

quality, for example compression artefacts; another possibility is that the video file being 

analyzed contains footage from old films. Photo flash, as you might find for example in footage 

depicting press conferences or in action sequences, can also cause too many cuts to be 

detected. If cuts are not detected, this can be due to, for example, a crossfade or an overlay 

(e.g. a caption) which stretches over several shots. 

 

5.4.3. Extractors developed within the AdA Project 

Within the AdA Project, Christian Hentschel and Jacob Löbkens developed further extractors 

which are included from Advene version 3.13 (Linux only). In the paragraphs below, we will 

briefly introduce the AdA Motion Dynamics Extractor and the Dominant Color Extraction. 

 

AdA Motion Dynamics Extractor 

The Motion Dynamics Extractor allows you to calculate a magnitude of movement from the 

video codec. The magnitude of movement is specified relatively between 0% and 100%, with 

100% being the respective maximum value for the specific video. This can provide a quick, 

broad overview of the dynamic profile of a sequence. 

 

 
 

The following parameters can be adjusted: 

 

The timecode of the generated data can be adjusted with an “offset”. 

 

The “step_size” specifies between which intervals the motion dynamics are calculated, i.e. at 

which interval a sequence for calculation begins. The default value is 300 milliseconds. 



 

87 
 
 

 

The “window_size”, in turn, sets at which interval a frame is extracted, i.e. the duration of the 

sequence for which a magnitude of movement value is calculated. The default value is 300 

milliseconds. If the window and step size are the same value, the motion dynamics will be 

extracted for exactly the interval between two frames. 

 

 
 

Note: The calculation may differ from human experience. This means, for example, that the 

film grain of archive footage can be displayed as excessive movement, since the texture of the 

picture constantly triggers all parameters, whereas visual inspection of the picture may detect 

lack of movement throughout. 

 

Dominant Color Extraction 

The Dominant Color Extraction performs a color analysis which outputs the color values of a 

segment as a list of color names in text format. The goal is to list the most common color 

shades in a specific sequence. In doing so, the extractor uses the dominant pixel amounts in 

the color distribution as the deciding factor. This means that, for example, an individual bright 

red spot in a dark scene will mostly not be detected. 

 

Various parameters allow you to adjust the extractor, such as the option to choose between 

the cie-lab, hsv and rgb color spaces. The parameter “source-type-id” can be used to select 

which annotation units are used as segments for the calculation. Brief descriptions of the 

respective parameters are displayed by hovering over the respective input field. It is still a 

challenge, currently, to reconcile the extractor with human color perception. 
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5.5. Importing external files (Import File) 

To import the contents of a file that was not generated in Advene, open the “File” menu and 

select “Import File”. 

 

Note: If you want to import a different annotation package, use either the "Import package" or 

the "Merge packages" feature. 

 

 

 
 

Select the desired file in the window that opens on the screen. 

 

This file will now be displayed in the “Importer”. Select the appropriate filter for the file in the 

dropdown menu and start the process. The imported file will subsequently be available as 

annotations within a new, automatically generated annotation type. 
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The filters can be used as presets for importing various file formats. As a result, the additional 

setting options for importing files will change depending on the filter you select. 

 

 
 

To import subtitle files, use the “Subtitle (SRT) importer” filter. 

(For an illustrated step-by-step guide, see: Importing subtitles) 

 

To import CSV or TSV tables (and therefore, for example, the results provided by an automated 

detector), use the “Text importer” filter. 

 

For other commonly used video annotation software, you can use the following filters: “VIAN 

importer”, “ELAN importer”, or “Anvil importer”. 
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6. Correcting annotations 

Advene provides various features that can simplify the correction of both automatically 

generated and manually created annotations. You can use the Shot Validation View to check 

shot boundaries, in particular the results produced by the automatic shot segmentation. The 

Checker offers various functions to reveal and correct potentially faulty annotations for various 

annotation types. Both correction view modes and their functions will be briefly introduced in 

the following paragraphs. 

 

6.1. Shot Validation View 

You can use the Shot Validation View to manually check and correct shot boundaries, 

particularly the results produced by the automatic shot segmentation. To open it, right-click the 

annotation type you want to check (the track generated by the automatic shot segmentation is 

automatically named Detected shots) and select “Shot validation view…”. Execute the process 

for the entire track, as explained below. 
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The Shot Validation View displays all detected cuts consecutively for you to review. The 

detected cut is situated between the shot with a pink background and the one with a black 

background. 

 

If this cut detection is correct, click on “Next cut >” to jump to the next cut you have to check. 

By clicking on “< Previous cut”, you will be taken back to the last cut before the current one. 

 

Click on “Current time” to shift the Shot Validation View to the current video player timecode. 

 

 
 

If there is no corresponding cut present in the selection of displayed frames, you can merge 

the two underlying annotations by clicking on “Merge”. 

 

If the selection of displayed frames does contain a cut, but it has not been correctly detected, 

you can click on the first frame of the second shot to move the annotation boundary to the 

correct position. 
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If not all or none of the frames have been loaded, you can click on “Refresh” to replace the 

placeholders with the actual frames. 

 

 
 

If an additional cut needs to be added to the one displayed, you can insert it by holding down 

the [CTRL] key and clicking on the first frame of the shot after the cut. If the missing cut is 

located outside the displayed frame, you can use the arrow buttons or the arrow keys on your 

keyboard to navigate towards the left or right of the frames until you reach the desired spot. 

 

Note: When editing complex cutting patterns in the Shot Validation View, it can happen that 

individual, overlapping annotations of minimal length are created. These can be most easily 

detected and corrected with the Checker. 

 

Tip: After you finish checking, we recommend you renumber the annotations contained in the 

now verified annotation type by using the “Renumber annotations…” function. 
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6.2. Checker 

You can use the Checker in various ways to inspect annotations that possibly have errors. 

To open the Checker, go to the “View” menu and select “Checker”. 

 

 
 

This will open the Checker in a Workspace (normally, on the right-hand side of the video 

player). We will now briefly introduce the most important functions of the Checker. 

 

6.2.1. Overlapping 

The “Overlapping” tab displays all annotations that partly or completely overlap each other. 

The red background color shows if an annotation overlaps another annotation at its starting 

point, at its end point, or completely. Such annotations can appear, for instance, after checking 

with the Shot Validation View. It can also happen that shorter annotations become completely 

hidden underneath longer ones in the Timeline View and are therefore only visible in the 

Checker. 

 

Tip: We recommend you to only add overlapping annotations deliberately and on a case-by-

case basis, e.g. for describing two montage principles that overlap each other in a central point. 
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6.2.2. Completions 

Note: It makes sense, for certain annotation types, to specify a selection of possible values 

(for example, a series of field sizes). These can be saved as “predefined keywords”. 

 

The “Completions” tab will display all annotations currently assigned to a specific annotation 

type, but their content, however, does not match any of its predefined values. This can be due 

to the fact that the entered values are not on the set list for this track; alternatively, the cause 

can also be typing errors, which this tab makes easier to detect. 

 

Tip: This function can also be used to check if individual annotations contain any comments. 

This allows you – as in the example below – to mark annotations for later discussion as “tbd”. 

 

 
 

6.2.3. Duration 

In the “Duration” tab you will see all annotations that have no set duration. Such annotations 

can be generated, for example, when performing checks with the Shot Validation View. 

 

 
 

Since they have no duration, these annotations are not displayed in the Timeline View, but can 

lead to problems later on, since Advene, for example, takes them into account when 

renumbering. 

 

Tip: Annotations with a duration shorter than one frame (e.g. under 40 ms at 25 fps) can also 

lead to problems. These are not covered by the Checker but can be found in the Table View. 

In this view mode, click on “Duration” to sort annotations by duration. 
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6.2.4. Empty Content 

In the “EmptyContent” tab you can see all annotations that have been generated but not (yet) 

filled with a value. This allows you to check if you missed any annotations during the annotation 

process. 

 

Note: If the “Use UUIDs” box has been ticked in the “General” tab of the “Preferences”, each 

annotation has been assigned an UUID (universally unique identifier). This UUID will be 

displayed under “Content” as long as the annotation does not have any actual content. 
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7. The Search Function 

At the very right of the toolbar, you can find a search field with typical search functionality. 

 

 
 

Search results will consist of all annotations that include the search term, listed in the Table 

View. This will display not only the search term, but also the entire content of the annotation. 
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The search results also contain annotations in which the search term is only a part of the value 

content. This means, for example, that searching for “closeup” will also include annotations 

with the value “shoulder_closeup”. 

 

 
 

The search process scans all annotations inside the open package and therefore also displays 

annotations from different annotation types. For a better overview, you can click one of the 

columns to re-sort the search results, for example, by “Type”. 

 

 
 

In addition, search results can be visualized in various ways. 
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Displaying search results in a Timeline 

If you click on the Timeline icon to the very left, search results will be displayed in a Timeline. 

 

 
 

In the Timeline View, only those annotations containing the search term will be displayed. 

Other annotations that belong to the same annotation type will not be displayed. This function 

can be helpful, for example, in order to track the frequency of a value across various annotation 

types. 

 

 
 

Highlighting search results in the Timeline View 

If you click the light bulb symbol, search results will be highlighted in yellow in the Timeline 

View. 

 

 
 

  



 

99 
 
 

The Timeline View will then resume displaying all annotations that belong to the respective 

annotation types. The annotations containing the search term will appear highlighted in yellow. 

This function lends itself, for example, to track where a specific value occurs. 

 

 
 

Searching by UUID 

If the “Use UUIDs” box has been checked in “Preferences”, under the “General” tab, which 

means that each annotation has been assigned an UUID (universally unique identifier), you 

can search for specific annotations in a package based on this ID. Since UUIDs are not 

repeated even across packages, you can thus find individual annotations across packages. 

 

In order to be able to search by UUIDs, you have to adjust the search function. To do so, right-

click the magnifying glass icon next to the search field and select the “Searched elements” 

option. 
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In the window that pops up, select the option “Ids” (at the end of the list). 

 

Tip: This menu additionally enables you to limit the search to individual annotation types, so 

that, for example, only results from one track are displayed. 

 

 
 

Now the UUIDs of all annotations will be scanned and displayed as search results if applicable. 

 

Tip: In order to copy the ID of an annotation to the clipboard, right-click the desired annotation 

and select “Copy id (…)”. 
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8. Visualizing annotations 

Advene offers various features for visualizing annotations. In the paragraphs below, we will 

briefly introduce the most important forms of representation. 

 

Tip: If you are working with the AdA Template, you have access (in addition to the 

visualizations listed below) to the AdA Timeline, a very comprehensive and highly 

customizable visualization option. 

 

8.1. Views 

Advene allows you to visualize and edit annotation data within various view modes. Different 

view modes are better suited to different tasks. The view modes can be opened both by 

pressing the symbols in the toolbar and by using the “View” menu. In the Timeline View, 

multiple annotation types can be displayed in parallel as tracks. In the Table View, annotations 

are rendered in table form, while in the Transcription View they are represented as flowing text. 

The latter two always depict annotations from a single annotation type. Individual annotations 

can also be displayed and edited in the Edit View. There is also a separate Edit View for editing 

individual annotation types. 

 

Tip: If you do not want to create the selection and order of the annotation types displayed in 

the Timeline every time you start Advene, you can save the Timeline View. In the same 

manner, you can save different views for different work stages under the same package. 

 

In the Package Finder you can see and manage all elements contained in a package. 

 

You can use the Note-taking Editor to freely transcribe longer texts and consequently convert 

them into annotations. 

 

Aside from these views, there are other forms of function-bound visualization, such as the 

Checker, for verifying data input, or the Shot Validation View, for controlling shot boundaries. 
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8.2. Caption Dynamic View 

If you right-click an annotation type in the Timeline View and select the “Generate a caption 

dynamic view…” option, you can generate a dynamic view of this track. The content of 

annotations on the selected track will now be displayed in the video player as subtitles. 

 

(For an extensive presentation of the Caption Dynamic View, see: Dynamic views) 

 

 
 

8.3. Montage 

A montage allows you to freely combine different annotations and thereby generate a 

compilation of the sequences of the video assigned to the respective annotations. 

 

To open the Montage, click the montage symbol in the toolbar. 

 

 
 

You can alternatively open the Montage by going into the “View” menu and selecting the 

“Montage” option. 
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This will open the Montage view. You can now drag-and-drop single annotations but also a 

selection of annotations into this view. The order of the annotations in the Montage can also 

be changed by dragging-and-dropping. To delete an annotation from the Montage, drag-and-

drop it onto the red circle icon. 

 

The minus and plus symbols allow you to zoom out or in. You can either use one of the preset 

values or manually type in a value between 1 and 100. Clicking on  will reset the entire 

area to 100%. 

 

 
 

If you click on the light bulb symbol, annotations will be highlighted in yellow both in the 

Montage and in the Timeline View. 
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You can save the Montage as a View by clicking on the save icon. In the window that opens 

up, you can assign a name and an ID for the Montage. 

 

 
 

To export the Montage as a video, right-click on the “Montage” tab and select the “Render” 

option. 

 

Note: To be able to use this function in the Linux version, you need to first install it with the 

terminal command: apt install gir1.2-ges-1.0. 

 

 
 

In the window that pops up, you can name the clip, choose a save location, and confirm with 

“Save”. 

 

8.4. Histogram 

To generate a histogram, select the W3 symbol in the toolbar and click on the “Histogram” 

option. 

 

Note: If you are using the AdA Template, the histogram is automatically based on the 

annotations in the annotation type Seg | Shot. 
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A browser window will now open, in which annotations are represented as a bar chart in 

proportion to their duration. The longer an annotation – in our example of Seg | Shot, one shot 

– the higher and wider the bar in the histogram. 

 

 
 

Clicking on one of the bars makes the video player in Advene jump to the beginning of the 

underlying annotation. If you move the mouse pointer over the duration information (listed on 

the left side in the example below), only those annotations corresponding to the selected 

duration span will be displayed. 
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9. Statistical analysis 

To open statistics for an annotation type, which means an overview of the annotations available 

on this track, right-click the desired annotation type and select the “(…) – statistics” option. 

 

 
 

In the new window that opens up, you can see an overview of the number, duration, and values 

pertaining to the annotations available on this track. 

 

 
 

In addition, you can also display statistics for a selection of annotations. 

 

 
 

Right-clicking the selection and choosing the “Display statistics” option will open statistics for 

this selection of annotations. 
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The window that pops up will now show you an overview of the number, duration, and values 

pertaining to the selected corpus of annotations. 

 

 
 

Tip: For a more extensive statistical analysis, we recommend exporting the annotations as 

CSV or TSV, which enables you to evaluate the data in other software. 
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10. Exporting 

Annotations created in Advene can be exported as CSV or TSV files in order to use them in 

other software. In addition, you can extract stills and clips based on annotations. Both export 

options will be detailed briefly in the paragraphs below. 

 

10.1. Exporting annotations 

In order to continue working with annotation data in other software, you can export this data in 

various formats. We will explain the exporting process for CSV and TSV files below. 

 

Exporting annotations as CSV files 

Right-click on “Annotation table view” in the Table View and select the option “Export as CSV” 

to export the content of the table as a CSV file. 

 

 
 

This format allows you to import annotation data into different contexts – for example, the VIAN 

annotation software – or to visualize it by using spreadsheet software. 
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Exporting annotations as TSV files 

Various export filters can be selected by opening the “File” menu and selecting the “Export…” 

option. For example, you can export all annotations within a package as a TSV fi le by using 

the “Spreadsheet (tab separated values)” filter. In addition, key information pertaining to all 

annotations – start and end timecodes, duration in milliseconds, type description, as well as 

annotation content – will be exported in table format. 

 

 
 

Note: The current Advene version does not allow you to modify the save location and file 

name. This problem should be fixed in future versions. 

 

10.2. Extracting stills and clips 

Extracting stills (Save as...) 

To extract a still from the linked video file, go to the Inspector and right-click on the snapshot, 

then select the “Save as…” option. 
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Alternatively, you can navigate to the desired timecode and right-click on the picture. The 

“ActiveBookmarks” view will then open, and a “bookmark” will be created. To extract a still, 

right-click on the desired “bookmark” and choose the “Save as…” option. 

 

 
 

In both cases you can choose a name and save location for the still in the window that appears 

on the screen and confirm with “Save”.  

 

Extracting clips (Extract Video) 

To extract a video, right-click on a selection of annotations and choose the “Extract video” 

option. 

 

Note: To use the “Extract video” function in Linux, you first need to install it by using the 

terminal command apt install gir1.2-ges-1.0. 

 

 
 

In the window that appears on the screen you can choose a name and a save location for the 

clip; confirm with “Save”. 

 

Tip: It is also possible to compile a montage from individual annotations and export it. 
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11. Shortcuts 

You can significantly simplify and accelerate your work with Advene by using numerous key 

combinations. The main shortcuts will be presented below. 

 

Note: Key combinations in Advene can also be found in the “Help” menu, under “Display 

shortcuts”. You can find other shortcuts detailed at: 

https://github.com/oaubert/advene/wiki/AdveneShortcuts 

 

General 

[CTRL] + [z]: undo last performed action 

[CTRL] + [s]: save package 

 

Video player 

[CTRL] + [space] or [CTRL] + [tab]: start/pause 

[CTRL] + [left]/[right]: jump forward/back 

(The desired jump duration can be manually set in "Preferences".) 

[CTRL] + [down]/[up]: jump a frame forward/back 

(this has to be manually adjusted to the video framerate in "Preferences".) 

[esc]: leave fullscreen mode 

 

Timeline View 

[CTRL] + [+]/[-]: zoom in/out 

[CTRL] + [number]: adjust zoom level from 100% ([CTRL] + [1]) to 2% ([CTRL] + [9]) 

 

Note: To select an annotation, either click on it or move the mouse pointer on top of it. A thick 

black border shows you the currently selected annotation. 

 

[backspace]: delete selected annotation 

[space]: the video player jumps to the beginning of the selected annotation 

[CTRL] + [enter]: split selected annotation based on current timecode 

move mouse pointer to the beginning/end of an annotation + [CTRL]: the start/end time of the 

annotation will be adjusted to the current video player timecode 

[1]-[9]: selected annotations can be ascribed values through the Quick fill feature by using the 

number keys 

 

Quick edit 

[enter]: open selected annotation in edit mode 

press [enter] again: confirm changes and close annotation 

[esc]: close annotation currently open in edit mode without saving changes 

[tab]: confirm changes, close annotation, and open next annotation 

 

Table View 

[enter]: open selected annotation in edit mode 

press [enter] again: confirm changes and close annotation (the next annotation is then 

automatically selected, which can be opened directly by pressing [enter]) 

https://github.com/oaubert/advene/wiki/AdveneShortcuts
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[CTRL] + [enter]: open the Edit View for the selected annotation 

[space]: jump to the beginning of the selected annotation in the video player 

[up]/[down]: navigate up/down in the table 

 

Note-taking Editor 

[CTRL] + [enter]: insert timestamp corresponding to the current timecode in the video player  

 

12. Accessing log files (Open logfile folder) 

If you encounter problems with Advene, log files – automatically generated files that record 

processes running in a system or a program (in this case Advene) – may help you diagnose 

or communicate potential errors. To access the folder that contains the log files, choose the 

“Open logfile folder” option in the “Help” menu. 

 

 
 

We recommend sorting the documents in the folder that appears on the screen by the date 

they have been edited, in order to see the latest log files at the very top of the list. 
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IV. Working with the AdA Filmontology – Step-by-Step Guide 

Within the framework of the AdA Project, an extensive corpus of feature films, documentaries, 

and news segments dealing with the global financial crisis (2007–) was comprehensively 

annotated by a team of expert annotator film scholars. The following step-by-step guide 

reproduces the fundamental stages of the analysis practices we developed and demonstrates 

how an interpersonal annotation process is facilitated by the corroboration of annotation 

software, annotation routines, and a structured analysis vocabulary, which allows for greater 

comparability of the annotation data. 

 

The basis for these annotations, which are available as Linked Open Data, is the AdA 

Fimontology vocabulary (for an overview and insight into the AdA Filmontology, see also 

https://projectada.github.io/ontology/ and Bakels et al. 2020). The vocabulary is structured on 

three tiers:  

- Overarching analytical dimensions, such as image composition or acoustics have been 

compiled as Levels. 

- These are subdivided into various Types, which correspond to concrete aesthetic 

parameters of film analysis (CameraAngle, CameraMovementDirection). 

- Within these types, different Values can be assigned to specific segments of a video 

file. 

 

In total, the AdA Filmontology encompasses 8 levels, 78 types, and 503 values. Levels and 

types depict a structural order of film analysis attributes, while values represent concrete 

attributes for specific segments of a video file. All levels, types, and values are outlined as film 

analysis concepts in short definition texts. 

 

https://projectada.github.io/ontology/
https://dh2020.adho.org/wp-content/uploads/2020/07/488_AdAFilmontologyamachinereadableFilmAnalysisVocabularyforVideoAnnotation.html
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Visualizing the AdA Filmontology in LOD-View. Levels – Types – Values. 

 

You can find a compact presentation of the entire vocabulary here: AdA Filmontology – Levels, 

Types, Values. 

Further guidelines for annotation practices, which include usage tips as well as the 

segmentation and annotation decisions of the AdA Project can be found here (in German only): 

Hinweise zum projektbasierten Annotieren mit der AdA-Filmontologie. 

The AdA Filmontology has been set up so that it can be freely sourced, used, expanded, and 

modified under a Creative Commons Attribution-ShareAlike 3.0 license. 

 

In the following step-by-step guide, we will not explain the film analysis background for 

individual annotation types, but rather the technical and practical basic concepts for 

annotation-based analysis in Advene using the AdA Filmontology. 

 

There is a template for annotations that provides you with the entire analysis systematic as a 

vocabulary in Advene. To download the AdA Template for Advene: 

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html. 

 

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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This template contains the various types as annotation types, which can be directly displayed 

in the Timeline View. These annotation types already contain the values from the AdA 

Filmontology as “Completions”. This also includes various syntax elements for combining 

values. 

 

The AdA Template additionally contains a saved AdA Corpus Analysis View, which 

encompasses the so-called base tracks, i.e. 21 selected types. These can be viewed directly 

in the Timeline View. The base tracks have been compiled to serve as basis for a comparative 

analysis of the primary audiovisual dynamic. Other types can always be added as necessary 

or expanded through your own analytical dimensions. 

 

For annotating entire films, annotation was divided by scenes between multiple annotators in 

the AdA Project. A first step in the work process is the scene segmentation, which is performed 

by two people independently; this is then compared and finalized by a third person, who has 

seen the film beforehand, but not divided it into scenes. This process is based on the eMAEX-

Method. Annotation packages containing basic data (scenes, shots, sound volume, subtitles) 

are then created for the entire film and subsequently divided by scenes. Following the 

individual annotation process, the scenes are put through an editing process and combined 

into a package for the entire film. (For shorter audiovisual formats or annotations made by a 

single person, these steps of dividing and combining scene packages are not necessary.) The 

resulting structured annotation data can now be visualized in various ways, for analysis 

purposes, or exported for further use in other contexts. 

 

The following outline, as a structured overview of the steps in the AdA (annotation) routines, 

focuses on annotating entire films; it should, however, serve primarily as empirical reference 

and support for film analyses based on comparable annotation processes. 

 

  

https://www.empirische-medienaesthetik.fu-berlin.de/emaex-system/emaex_kurzversion/index.html
https://www.empirische-medienaesthetik.fu-berlin.de/emaex-system/emaex_kurzversion/index.html


 

116 
 
 

1. The AdA Template  

The AdA Template is an annotation package which already contains the vocabulary of the AdA 

Filmontology for annotating in Advene. All annotation types have been respectively defined 

and arranged in a color scheme, while the value presets are available as “Completions” and 

assigned to syntax elements. You can use the AdA Corpus Analysis View in the AdA Template 

to display the base tracks that were used in the AdA Project as the basis for comparative 

analysis in the Timeline View. The AdA Template can thus be used as an actual template in 

order to follow the analysis systematic of the AdA Project during the annotation process; it can, 

of course, be expanded at any moment through your own analytical dimensions. In addition, 

you can use the AdA Template to visualize annotations in the AdA Timeline, an html-based 

timeline. 

 

The AdA Template can be downloaded here. 

 

Tip: You can also implement the AdA Template onto an existing package, not only when 

creating a new one. For this purpose, the Ada Template package will be added to the existing 

package through the "Merge packages" feature. 

 

Note for the AdA routine: For all films and news segments in the AdA Corpus you can find 

individual Advene templates, in which annotations have been created for the corresponding 

video files, at http://ada.filmontology.org/corpus/. To check that the template and the video file 

match each other, you can use the "Verify video checksum" feature. 

 

1.1. Linking video files 

Open the AdA Template in Advene and link the desired video file. After doing so, check the 

video framerate and adjust the framerate accordingly in “Preferences”. 

 

1.2. Checking the video checksum (Verify video Checksum) 

For video files in the AdA Corpus, specific templates are available. The “Verify video 

checksum” feature allows you to ensure that you are using the correct file version of a video 

for annotating. To check if a video file is the correct match for its corresponding template, go 

to the “Player” menu and select “Verify video Checksum”. 

 

 
 

  

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
http://ada.filmontology.org/corpus/
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If the linked video file and the template contents correspond, the following notice will appear 

on the screen. 

 

 
 

Note: Unfortunately, this feature cannot be used externally, but should serve as an example 

for ensuring consistent data management in research projects. 

 

2. Preparing a package for annotation 

Before you begin adding annotations – which involves ascribing film analysis values to specific 

time segments of the video – we recommend implementing a few preparatory steps. Among 

these are shot segmentation and creating a volume waveform, both of which are supported by 

automated detectors. If subtitles are available, these can also be imported for the entire video 

file. During the AdA routine, these steps are performed for the entire film or video, which 

simplifies all further work – especially if the package is to be divided into multiple scene-based 

packages (in this case, for example, subtitles do not have to be imported for every scene 

package). 

 

2.1. Shot segmentation 

Many annotation types use the shot as their smallest unit. It makes sense, therefore, to perform 

a shot segmentation process before starting to annotate. The shot segmentation can be used 

at a later point as a basis for annotating in other annotation types. 

 

Note for the AdA Filmontology: A shot in a film is understood to be an impression of a visually 

continuous picture and is hence delimited by a ‘visual discontinuity within the general picture 

composition’ (Anton Fuxjäger, “Wenn Filmwissenschaftler versuchen, sich Maschinen 

verständlich zu machen”, in: Maske und Kothurn, 55/3 2009, p. 119). 

 

2.1.1. Automatic shot segmentation (ShotdetectApp importer) 

During the first step, an automatic shot segmentation for the linked video file is performed 

through the “ShotdetectApp importer”. To start this process, go to the “File” menu and select 

“Process video”. In the window that appears on the screen, select the “ShotdetectApp importer” 

“Filter”. The resulting automatically generated annotations will be displayed in the newly 

created annotation type Detected shots. 

 

Note: “ShotdetectApp importer” is only available for Linux. MacOS and Windows users can 

instead use “Scene change detection”. It offers less settings to adapt to the specific video but 

provides a basic shot segmentation. 

 

(For an illustrated step-by-step guide, see: Automatic shot segmentation (ShotdetectApp importer)) 
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2.1.2. Checking shot segmentation with the Shot Validation View 

In the following step, you can use the Shot Validation View to manually check the results of 

the automatic shot segmentation and make corrections if necessary. To do so, right-click on 

the annotation type you want to check (the automatically generated track is called Detected 

shots), select the “Shot validation view…” option and check the entire track cut by cut. 

 

(For an illustrated step-by-step guide, see: Shot Validation View) 

 

2.1.3. Examining shot segmentation with the Checker 

You can use the Checker in various ways to detect annotations that may be corrupted. To 

open the checker, go to the “View” menu and select the “Checker” option. When checking shot 

segmentation, the most relevant tabs are “Duration” and “Overlapping”. 

 

Duration 

The “Duration” tab displays all annotations that have no duration. These annotations are not 

displayed in the Timeline View, but can still lead to problems, since Advene, for example, takes 

them into account when renumbering. Annotations without duration should therefore be 

deleted. To do so, right-click on the annotation, click on the top row of the menu that opens 

(this will display the content of the annotation) and select the “Delete” option. 

 

 
 

Overlapping 

The “Overlapping” tab displays all annotations that partly or completely overlap with one 

another. Again, you delete all annotations without a duration or with a duration shorter than 

one frame (e.g., under 40 ms at 25 fps). If you click on “Duration”, all annotations will be sorted 

by their duration. 
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You can now delete all annotations without a duration or with a duration shorter than one frame. 

To do so, right-click on the annotation, click on the top row of the menu that opens (this will 

display the content of the annotation) and select the “Delete” option. 

 

Note: You have to resort the list by duration every time after deleting an annotation. 

 

All further errors can be left as they are, since they will be fixed in one of the following steps. 

 

2.1.4. Checking shot segmentation in the Table View 

In this step, all annotations with a duration shorter than one frame that were not listed in the 

Checker can be deleted. To do so, right-click on the annotation type you want to check (in the 

case of automatic shot segmentation, the generated track is called Detected shots) and choose 

the “Display annotations in table” option to open the Table View. 

 

 
 

If you click on “Duration”, all annotations will be sorted by duration. You can now delete all 

annotations with a duration shorter than one frame (for example, under 40 ms at 25 fps). To 

do so, right-click on the annotation, click on the top row of the menu that opens up (this will 

display the content of the annotation) and choose the “Delete” option. 

 

Note:  You have to resort the list by duration after deleting every annotation. 
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2.1.5. Checking shot segmentation in the Timeline View 

In this step, all annotations of the shot segmentation can be checked in the Timeline View and 

aligned with each other frame-to-frame. 

 

Warning: Since the Shot Validation View and the Timeline View access the video file in 

different ways, there may be minor discrepancies between them. 

 

Note for the AdA routine: Discrepancies of a single frame (for example, 40 ms at 25 fps) will 

not be corrected, but instead accepted as margin of error. 

 

2.1.5.1. The first and the last annotation 

The first annotation should begin at 00:00:00.00. To check if this is the case, click on the 

annotation (it will then be displayed on the bottom right in the Inspector) and check the start 

time. 

 

 
 

If the start time is not 00:00:00.000, open the annotation for editing in the Edit View. To do so, 

right-click on the annotation, click on the top row of the menu that opens up (this will display 

the content of the annotation) and choose the “Edit” option. Now you can manually insert the 

start time for the annotation under “Begin” (00:00:00.000) and apply the changes. 

 

 
 

In the same way, you can now make sure that the last annotation lasts until the end of the 

video. For the end time, drag the pointer in the video player all the way to the right and use the 

displayed time to check with the Inspector and, if necessary, adjust it in the Edit View. 
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2.1.5.2. Checking other annotations in the Timeline View 

In this step, you can use the Timeline View to make sure that each shot in the video 

corresponds precisely to one annotation, and that the annotation boundaries match the cuts in 

the video. 

 

AdA routine for crossfades: The cut is made when the first shot (from which the crossfade 

starts) is no longer visible, and the only visible shot is the second one (to which the crossfade 

leads). For fade-ins or fade-outs, this rule (to set the cut to the point where the picture no longer 

gets brighter or darker, respectively) can distort the rhythm of the sequence. This can make a 

succession of soft fade-ins or fade-outs falsely appear in the shot segmentation as a montage 

with a rapid cutting rhythm. Because of this, we recommend making decisions based on visual 

interpretation when it comes to fade-ins and fade-outs, to decide if they belong to the previous 

shot, or should be separately annotated as a black or white image, respectively. Indicators for 

a separate annotation of the black or white image can be, for example, a certain duration, but 

also a potential off-screen comment or music. 

 

AdA routine for split screens: Shot changes are only recognized in the annotation type Seg 

| Shot if they occur in all picture segments at the same time. Cuts that do not occur 

simultaneously in all picture segments of a split screen (for example, a cut occurs on the screen 

at the right side, but not the left) will be annotated in the annotation type Seg | Shot Duration. 

The annotation will in this case be split in the Seg | Shot Duration track, but not the Seg | Shot 

track. 

 

Tip: Make a note of the split screens during this step and insert them later when adjusting the 

annotation type Seg | Shot Duration. 

 

Cuts in the wrong position: 

To check the annotation boundaries, play the video and pause it at each cut and each transition 

to compare the position the annotations are split. To check this, click on the annotation of the 

new shot (the video player will then automatically jump to the first frame assigned to this 

annotation). 

 

 
 

You can now go back one frame in the video player (or two, respectively) using the double 

arrow symbol with a line on the left end. 

 

Tip: You can also do this by using the [CTRL] + [down] shortcut. 
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You should now be able to see the previous shot. If this is not the case, you have to correct 

the cut. To do so, navigate in the video player to the first frame of the new shot and set the cut 

to the correct position by right-clicking on the annotation and selecting "Split at current player 

position". 

 

 
 

After this, merge the separated part of the annotation with the other annotation to which it 

belongs. 

 

 
 

Also keep an eye out for missing or redundant cuts when checking the annotation boundaries. 

 

Missing Cuts: 

If an existing cut in the video is missing in the annotation, navigate to the first frame of the new 

shot in the video player and divide the annotation by right-clicking on it and selecting "Split at 

current player position". 

 

Warning: Pay attention to jump cuts, since these are often not detected by the automatic shot 

segmentation. 

 

Redundant Cuts: 

If a cut exists in the annotations, but there is no actual cut in the video, merge the two 

annotations. 

 

Note for the AdA routine: Time lapses are usually annotated as one continuous shot. 
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2.1.5.3. Aligning annotation boundaries according to frames 

To ensure that there are no gaps between the annotations and to eliminate a large percentage 

of the overlapping ones, this step will show you how to align annotations to one another. 

 

To do this, drag-and-drop each annotation onto the following one; in the window that appears 

on the screen, select "Align end time to selected begin time". 

 

 
 

This will align the end time of the first annotation to the start time of the second one, the 

correctness of which has already been checked in the previous step. This fixes most errors 

that are displayed in the Checker under "Overlapping". 

 

Tip: Before implementing this step, renumber the annotations. Now, when aligning the 

annotations, keep your own mental count and check if the specific number in your count 

matches the name of the annotation. Discrepancies can reveal hidden annotations or other 

problem areas instantly and allow you to fix them. 

 

2.1.6. Checking shot segmentation again with the Checker 

Finally, you should use the Checker to perform one more verification. At this point, you should 

not find any more annotations under “Overlapping” and “Duration”. Should you still notice any, 

right-click on the annotation(s) and use the “Go to…” option to jump directly to the problem 

area. 
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It may be the case, as in the example below, that a shorter annotation is completely hidden 

underneath a longer one, which makes it easy to overlook it when performing the check. 

 

 
 

In the example below, the shorter annotation is not visible in the Timeline View (see picture on 

the left). If you copy the visible annotation to the track below and then delete this annotation 

from the original track, you will be able to see the annotation previously hidden underneath it 

(see picture on the right). This latter one can now be deleted, and the longer annotation can 

be copied back to the top track. 

 

  
 

If you cannot detect the problem in a specific area, the annotations involved can be deleted 

and then manually recreated, as well as aligned to one another. 
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2.1.7. Renumbering annotations 

Finally, renumber the annotations in the Detected shots annotation type. 

 

2.1.8. Copying annotations from Detected shots to the Seg | Shot and Seg |Shot Duration 

annotation types 

You should now copy the annotations from theDetected shots to theSeg | Shot and Seg | Shot 

Duration annotation types . To do so, drag-and-drop Detected shots onto the desired track to 

which you want to copy the annotations, and select "Duplicate all annotations to type …". 

 

 
 

Afterwards, the annotation type Detected shots can be deleted. 

 

Note: The duration of respective shots will automatically be displayed as annotation content 

on the Seg | Shot Duration track. 

 

2.1.9. Making adjustments to the Seg | Shot Duration annotation type 

In the annotation type Seg | Shot Duration, any existing cuts in split screen situations will be 

added according to the AdA routine for split screens. 

 

2.2. Creating a volume waveform 

In order to automatically generate a volume waveform for the video file, go into the “File” menu 

and click on the “Process Video” option; select the “Sound enveloppe” “Filter”. 

 

(For an illustrated step-by-step guide, see: Creating a volume waveform (Sound enveloppe).) 

 

Once this is done, copy the generated annotations using the “Duplicate all annotations to type 

…” feature from the automatically generated annotation type Sound enveloppe to the As | 

Volume annotation type. Afterwards, you can delete theSound enveloppe annotation type. 
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2.3. Importing subtitles 

If subtitles for a film or video are available, this can significantly simplify and thereby accelerate 

annotations in the annotation type Lg | Dialogue Text. If there are no subtitles or a similar form 

of textualizing spoken content, the dialog has to be annotated manually, in which case you can 

skip this step. 

 

Import subtitle files into the package using the “Import File” feature and the “Subtitle (SRT) 

importer” filter. 

 

 
 

The subtitles are now available as a separate annotation type and should be checked during 

the next step to see if they synchronize to the spoken content. It can be helpful to display a 

Caption Dynamic View of the imported subtitle track. 

 

Tip: If there are multiple subtitle files, it makes perfect sense to import the different files and 

compare them to see which file most accurately reflects the spoken content. 

 

If you discover that all annotations consistently start too early or too late, this shift can 

theoretically be remedied when first importing the subtitle file by setting an “offset”. It is easier 

to move the annotations after importing the file, instead of reimporting the subtitles. To achieve 

this, right-click on the annotation type, then select the name of the track in the top line and then 

the "Offset" option. 

 

If only individual annotations start too early or too late, their start and end times have to be 

manually adjusted. 

 

(For editing annotation boundaries, see: Creating and editing annotations) 

 

Tip: In order to avoid small discrepancies that may not be noticeable at the beginning of the 

film (for example, that annotations always come in a little too early) but add up throughout the 

duration of the film, it makes sense to test the synchronicity at the beginning, middle, and end 

of the video. 

 

Note for the AdA routine: Annotations should roughly match the spoken content in terms of 

timing, but do not have to be adjusted to match within one exact individual frame. 
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In addition to annotation boundaries, you have to also check the annotation content, or the 

formatting of this content, respectively, and make adjustments if necessary. The most 

important adjustments will be briefly explained below. In all cases, editing is done through the 

Edit View for individual annotations. 

 

Breaks in the text 

Text imported from subtitle files often contains (line) breaks. These can be detected in the Edit 

View through the numbering at the beginning of the lines. Since Advene only accesses the 

content before the first such break in other view modes, such as the Timeline View, the Table 

View, or the Transcription View, but also for the purpose of visualizing, these breaks should 

be removed from annotations. 

 

 🡪  

 

Character names: 

It can sometimes happen that the name of the character speaking is marked in the subtitle. In 

such cases, you have to remove the name. 

 

 🡪  
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Notes in the text: 

You should also remove noise descriptions (which are often provided in brackets) or notes 

about the spoken content being, for example, voice-over. 

 

 🡪  

 

Multiple speakers: 

It can happen, especially when verbal expressions are short, that several utterances by 

different people get summarized in one subtitle. If this is the case, you should split the 

annotation, based on the speakers in question, into several annotations. 

 

 🡪  

 

Finally, annotations can be copied into the Lg | Dialogue Text annotation type. You can then 

once again thoroughly check if they are complete and edit the wording or adjust the annotations 

to corresponding speech units. 
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2.4. Checking and adjusting scene boundaries 

Scene boundaries, i.e., the beginning and the end of annotations in the annotation type Seg | 

Scene, should precisely align with the beginning of the first shot annotation and the end of the 

last shot annotation for the corresponding scene in the Seg | Shot annotation type. Otherwise, 

individual annotations will be assigned to several packages when dividing them into scene 

packages. These double annotations can, in turn, create problems during a later merging of 

scene packages. 

 

If you click on an annotation, its start and end times will be displayed in the Inspector. This lets 

you compare the start time of a scene with the start time of the first shot in that scene … 

 

      
 

… as well as the end time of the scene with the end time of the last shot in the scene. 

 

      
 

If you encounter discrepancies, adjust the start and/or end times of the scene annotation in the 

Edit View until they match the shots. 

 

3. Creating scene packages (optional) 

In this last step before annotating, the film – provided it does not have to be annotated within 

a package – is divided into individual scene packages based on its division into scenes. This 

step is not necessary for shorter videos or, for example, news segments. 

 

  



 

130 
 
 

4. Annotating 

You can now begin the core work of annotating, i.e., assigning film analysis values to time 

segments of the video. For this purpose, annotations are created and filled with content as 

described below. 

 

As an entry point to the annotating process, we recommend the base tracks which can be 

accessed in the AdA Template as Ada Corpus Analysis View – a selection and sequence of 

annotation types saved as a Timeline View. To do this, drag the Timeline symbol from the 

toolbar onto a workspace in order to open a new Timeline, and select the saved view. The 

base tracks offer a cross-section of the various levels of analysis and can therefore make the 

underlying dynamics of a video more tangible. They can always be supplemented with 

additional annotation types based on the video and on your research interests. A detailed 

overview of all annotation types can be found in the AdA Filmontology. The base tracks are 

marked there with an asterisk. 

 

Note for the AdA routine:  

In the AdA Template, annotation types are assigned to eight schemata that correspond to the 

levels of the AdA Filmontology, such as Image Composition, Camera, or Acoustics. Even 

though the category designations suggest an orientation towards the film production process, 

annotations are primarily concerned with the perception of the viewer. When annotating, for 

example, the direction of camera movement, it is not crucial whether the camera actually 

moved towards the image object while shooting, whether the movement was produced through 

zooming, or whether this was achieved in post-production. Instead, it is the annotator’s 

impression of movement that decides on the annotation, and the camera movement would be 

described in all three cases as “forward”. A similar principle operates for the hierarchy of values 

in cases where several attributes are assigned to a single annotation. If there is no 

chronological order – such as a camera movement that first goes to the left and then up – 

which you can use to orientate yourself, it is your impression that decides the order. When 

annotating colors in a shot, for example, the most noticeable color is listed first. This can be, 

of course, the color that covers the largest area. It can also be, however, a color that creates 

a stronger impression, even though it covers a smaller surface. 

 

In general, you should try not to aim for absolute completeness when annotating, but rather 

focus on what you, the annotator, perceive as clear and important. If, for example, you 

annotated very slight low angle shots or minimal camera movements, you might distort your 

results. If you are annotating the ambient noise, this task is not about recording every single 

perceptible noise, but rather about rendering noticeable accents in their tonal properties more 

visible. 

 

Determining annotation values is not based on an absolute but rather on a relationally informed 

perception, which means that what is perceived as “bright” or “dark”, “fast” or “slow”, changes 

with every film. For a generally very dark film, for example a film noir, the “bright” value can 

also indicate a darker shot than it would in an overall brighter film. The values should be used 

consistently, of course, within the annotation process for a specific video; especially for tracks 

with multi-tiered values such as the field size, the process revealed by the individual 

annotations, e.g. a narrowing or widening of the image space, is more important than the 

individual absolute values.  

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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4.1. Creating annotations 

In this first step of the annotation process, annotations have to be created as time units. In 

many cases, the (semi-) automatic shot segmentation provides a basis for this. For annotation 

types based on this shot segmentation, e.g. ImCo | Field Size or Cam | Camera Angle, the 

annotations from the Montg | Shot track can be copied and the content of the annotations can 

be deleted with the "Search/replace content" feature. 

 

Annotations that contain multiple shots but are still based on the shot segmentation, e.g. 

annotations assigned to the Montage level, can be created in various ways. One possibility is 

to navigate, using the video player, to the beginning of the first shot in the annotation, create 

a new annotation there, and then manually set the end time for the annotation. Alternatively, 

the first and last shot of the annotation you want to create can be copied from the Montg | Shot 

track into the track you want to annotate, and the two can be merged by using the "Merge 

annotations" feature. 

 

There are also annotation types whose annotations are not based on shots, but rather require 

their own segmentation based on the respective descriptive dimension, and whose annotation 

boundaries are therefore freely set. This applies, for example, to all tracks in the Acoustics 

schema. 

 

Tip: Using keyboard shortcuts can significantly accelerate the creation of annotations. 

 

4.2. Filling annotations with content 

Annotations can either be filled with content directly in the Timeline View or in the Table View 

by using Quick edit. Annotation types for which a selection of set values is available as 

“Completions”, e.g. ImCo | Image Brightness or Camera | Camera Angle, can be filled 

particularly quickly by using Quick fill – the input of values using the number keys. 

 

Annotations that are filled with longer amounts of plain text, such as Lg | Dialogue Text, can 

also be annotated using Quick edit in the Timeline View or in the Edit View. For proofreading 

purposes, you can use the Transcription View or a Caption Dynamic View of the annotation 

type in a second step. 

 

Tip: Using keyboard shortcuts can significantly accelerate your annotation filling process. 

 

Using elements from the AdA Syntax 

In order to also be able to annotate dynamic sequences and contrasts, the AdA Filmontology 

provides two syntax elements that are not in themselves qualifying values, but rather describe 

the relationship between annotation values within an annotation unit. For example, if a camera 

approaches its reference object at a steady speed, the field size also changes through this 

approaching movement. Because the boundaries between field sizes are fluid, a further 

subdivision of the shot would not adequately reflect the impression created by perception. We 

recommend using syntax elements for such cases. 

 

Note: Like all other values, syntax elements need to be separated by commas when typing 

them in. 

https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
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The syntax element [TO] reflects a continuous development between two values within one 

annotation. For example, it can describe the change in field size through a camera movement 

(long_shot,[TO],close-up), the coming to rest of an image-intrinsic movement (3,[TO],1), or a 

change in brightness (medium,[TO],dark). 

 

The syntax element [VS] combines two contrasting values within one annotation. This allows 

you, for example, to describe opposite movement directions (left,[VS],right) or clashing moods 

(angry,[VS],joyful). 

 

Note: The AdA Filmontology tells you for which annotation types in the AdA Template one or 

both syntax elements is/are provided. 

 

5. Merging scene packages (optional) 

If the annotation process for a film has been divided into multiple scene packages, these can 

be merged back together in one package after the annotation process has been completed by 

using the "Merge Packages" feature, e.g. to create visualizations for an entire film. 

 

6. Checking data 

Once the annotation process has been completed as well as, if applicable, the merging of 

individual scene packages, we recommend using the Checker once again to look for potentially 

incorrect or corrupted annotations. 

 

Tip: After merging multiple packages, you should go to the Checker and focus especially on 

the "Overlapping" tab. If, when you split a package into scene packages, an annotation extends 

beyond a scene boundary, it will be assigned to multiple packages, which would lead to double, 

overlapping annotations when the packages are merged later. This problem occurs especially 

with annotations that are not based on shot segmentation, such as the volume waveform within 

the As | Volume annotation type, or the cross-scene music pieces in As | Music Mood. 

 

Note for the AdA routine: If a music segment extends beyond the boundary of one scene, 

that music segment gets annotated completely inside the scene package of the scene (and, 

accordingly, by the person responsible for annotating that specific scene) in which the longer 

part of the segment is located. Nevertheless, you should pay greater attention at the 

annotations in the As | Music track when merging scenes. 

 

Note for the AdA routine: Merging individual scene packages was always correlated with an 

editing process within the AdA Project. If, during the annotation process, it is unclear which 

value is to be filled in for a certain individual annotation, this annotation was marked “tbd” (“to 

be discussed”), in order not to unnecessarily delay the annotation process. During the editing 

process, the entire package would be searched using the keyword “tbd”, and the annotations 

displayed in a Table view would be edited or annotated by a different person. 
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7. Visualizing 

To ensure the resulting annotations make for a fruitful film analysis, there is an essential step 

you should include when “reading” and exploring annotation data. Various forms of 

visualization, or view modes, are used to achieve this. The greatest challenges in the AdA 

Project were the sheer quantity of data and the need for (systematized) visualization options 

for a larger corpus while at the same time taking into account the variation within individual 

research objects. This is why there can be no universal solution (even within a theoretical 

approach) for visualizing the temporal dynamics of various films and videos. This applies, 

among other aspects, to the interplay of various dominant staging levels: while the deciding 

factor for one sequence may be the cutting pattern and changes in the color scheme, other 

sequences may predominantly use music and camera movement to convey moods and 

meanings. We therefore resort to timeline visualizations which enable scholars without a 

background in programming to configure, rearrange, reshape, and adjust the visual 

representation directly (within certain, limited possibilities). With the AdA Timeline and the 

Annotation Explorer, we developed two approaches for visualizing, presenting, and exploring 

annotation data. 

 

Advene offers various Views for displaying annotations, for example the Timeline View as 

standard interface, which enables generic options for interacting with annotations, with their 

creation process, and exploration. We additionally used other configurations of the Timeline 

View in the AdA Project: the possibility to adjust the selection of displayed annotation types 

and change their order, a variable zoom function, or the option to extend color specification for 

annotation values. In order to process larger and more complex data sets and make them 

visually comprehensible, an html-based timeline – the AdA Timeline – was also developed 

within the project, which we will present in more detail below. This Timeline is not designed for 

creating and editing annotations but is used instead for data exploration and hypothesis 

presentation in regard to individual films. 

 

The Annotation Explorer was developed especially for the exploration and presentation of 

larger annotation corpora. Therefore, comparability between different films, various forms of 

querying the vast data set and online accessibility are the core functions of this tool. The 

Annotation Explorer showcases the 500,000 annotations of the AdA Project according to the 

linked open data principles, but can also be adapted to present other, similarly structured data 

sets. 

 

  

/Users/thomassc/Google%20Drive/AdA/AdA%20FU/Hauptphase/Publikationen/Manual/Audio-visual_Rhetorics#_The_
/Users/thomassc/Google%20Drive/AdA/AdA%20FU/Hauptphase/Publikationen/Manual/Audio-visual_Rhetorics#_The_
https://project1.ada.cinepoetics.org/explorer/
https://www.w3.org/DesignIssues/LinkedData.html
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7.1. The AdA Timeline 

To create mappings and dynamic web views, and for more detailed exploration, annotation 

data can be visualized in a dynamic browser-based timeline view, which was created in 

cooperative collaboration between the AdA Project and Olivier Aubert. Compared to the 

Timeline View implemented in Advene, the AdA Timeline is characterized by greater flexibility, 

more diverse visualization options, as well as an easier exporting process. The concept of this 

view mode is based on so-called film scores, which make the temporal dynamics of a film 

legible on different composition levels at the same time, as can be found, for example, in the 

work of Sergei Eisenstein, Dziga Vertov, and others. In a manner similar to scores for 

orchestral pieces, different, synchronous “voices” are represented below one another. Various 

visualization processes are brought together in the AdA Timeline. In the following paragraphs, 

we will first explain how creating an AdA Timeline works, in order to then guide you through its 

structure and functionality, as well as various rendering settings, how to integrate a video 

player, and export options. 

 

7.1.1. Loading the AdA Timeline 

To create an AdA Timeline in Advene, you need to make sure the annotation package is based 

on the AdA Template. A selection of visualization forms can then be opened by clicking on the 

W3 symbol in the toolbar. 

 

 
 

 
 

The Timeline visualization can be generated as both a “Timeline” and a “Timeline offline”. In 

the online version, up-to-date visualization databases are retrieved from the developer 

homepage; in the offline version, local resources of your current Advene version will be used. 

Both timeline options will be automatically opened into your default web browser but can also 

be opened in a different browser you have installed by using the URL. Since the link refers to 

a locally created virtual server, this URL cannot be shared with third parties. To do this, you 

need to submit the html export. 

 

Tip: Our recommended browsers for using the AdA Timeline are Mozilla Firefox and Opera. 

 

Note: There are small differences between the two timeline options, but their functionality is 

essentially the same. The following explanations relate to the online version; individual 

deviations for either version will be explicitly marked. 
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7.1.2. The structure and functionality of the AdA Timeline 

The dynamically adjustable AdA Timeline enables both an overview of the entire film, as well 

as the possibility to zoom in on detailed views when needed. The annotation data can be 

visualized in different rendering formats, and the rendering can be adjusted in multiple ways. 

You can also save the settings you want for a specific Timeline and can therefore transfer them 

to other visualizations. 

 

 
 

The Timeline consists of two tracks fixed at the top, the zoom control, which you can use to 

scale freely, and a reference track, which displays the selected area using a predefined 

annotation type. All annotation types below, in the main area of the Timeline, refer to the same 

time segment (the reference track), so that all cross-track values displayed underneath one 

another address simultaneous phenomena. 

 

Note: There is no reference track in the "Timeline offline", only a track for scaling that is not 

fixed when scrolling. For this reason, annotations in the main area are displayed directly and 

flexibly based on the selected zoom level, which means you do not have to reload the view 

mode every time. 

 

The subheadings on the right show the annotation type IDs of the tracks below them, while the 

labels on the left provide information about the annotation values contained within them. A 

legend can be toggled as needed on the right-hand side. The order and display form can be 

freely adjusted – in the Edit window (top right, under “Edit”), via the Timeline URL, or via the 
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Type selector. The Timeline or a selected area of the Timeline can be exported by using the 

three-dot symbol on the top left. 

 

You can find a demo of the dynamic Timeline, which can also be accessed without a locally 

installed version of Advene from various operating systems at: 

https://olivieraubert.net/hpi/timeline.html?all_values. Most settings which will be detailed in the 

paragraphs below can be tried out directly in this demo version. 

 

7.1.2.1. The zoom function 

The free zoom function enables various micro-views of annotation data, which is particularly 

useful when annotating entire feature films and documentaries. In order to define an area that 

you wish to have displayed, select the desired area in the top bar of the zoom control while 

holding down the left mouse button. 

 

 
 

Now the corresponding marked time segment will be displayed in the track below using a 

reference track, for example the scenes track or, as in the example below, the shots track. The 

corresponding annotation type, which is displayed as a reference track, can be freely defined 

in the Edit window (top right, under “Edit”) with the text module “&reference=ANNOTATION 

TYPE” – in this case, “&reference=Shot”. If you confirm this entry with “OK”, the editing window 

will close, and the Timeline will be reloaded with the new settings. 

 

 
 

All tracks situated below will then reflect the marked area, and no longer to the entire length of 

the video. 

 

https://olivieraubert.net/hpi/timeline.html?all_values
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The zoom area can also be defined with frame-to-frame accuracy using timecodes, for 

example in order to display precisely one scene. To achieve this, the start and end time can 

be defined in the Edit Window (top right under “Edit”) using the text module “&t=START 

TIME,END TIME – in the example below, “&t=00:00:32.658,00:01:19.094”. 
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7.1.2.2. Rendering formats 

The following rendering formats are common visualization options for the AdA Timeline. Most 

annotation data based on the AdA Template can be visualized in various ways. You can adjust 

the rendering formats either in the Edit Window (top right under “Edit”) or via the URL. 

 

The histogram 

This is not, strictly speaking, a histogram since you have to ensure synchronicity to other 

tracks. In this rendering format, the width and height of individual blocks correspond 

respectively to the duration of an annotation. You can adjust the color scheme and the 

maximum height of the columns. This rendering format is particularly well suited for visualizing 

the cutting rhythm. 

 

 
 

The bar graph 

In this rendering format, annotations are displayed as horizontal bars. Each defined value is 

assigned its own row and color, so that their progression is more discernible. If values have a 

certain sorting logic, this will be taken into account for the vertical arrangement of rows, so for 

example the vertical arrangement in the example below follows field sizes from close to far. 

 

 
 

Symbols 

Certain annotation types – for example ImCo | Dominant Movement Direction or Cam | Camera 

Movement Direction – can also be visualized as symbols, not only as bars. In the example 

below, the arrows refer to the directions of camera movement. 
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The waveform 

Numeric values can be displayed as a waveform with oscillations in both directions. This 

applies both to dense value series with an identical frequency – such as As | Volume – and to 

manually created numerical annotation values with individual annotation lengths – such as 

ImCo | Image Intrinsic Movement. 

 

 

 
 

Single-line rendering 

For a basic division of an annotation type in which annotation values do not overlap – such as 

Motf | Setting or (if only one value has been assigned to each annotation), as in the example 

below, As | Dialogue Emotion – you may want to use a single-line rendering format. 

 

 
 

Color values 

Annotating color values, whether you are doing it for a color palette or for accent colors, can 

be displayed as a bar chart in which the bar colors correspond to the annotated colors. 

 

 
 

The line chart 

Numerical values can be displayed as a line chart. This applies both for dense value series 

with an identical frequency – such as As | Volume – and to manually created numerical 

annotation values with individual annotation lengths – such as ImCo | Image Intrinsic 

Movement. Annotation metadata can also be visualized as a line chart, as for example (see 

below) the annotation duration of a transcript in milliseconds. 
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The transcript 

Longer pieces of text, such as may occur for example in Lg | Dialogue Text, can be rendered 

as a transcript connected to the video player. When you click on a text passage, the video 

player jumps to the corresponding position in the embedded video. 

 

 
 

An example of an AdA Timeline with an embedded video and transcript can be found here: 

http://olivieraubert.net/hpi/timeline.html?data=timeline.json&media=http%3A%2F%2Fada.film

ontology.org%2Fvideos%2Fpublic%2FDokumentarfilme%2FMaltsev_Sem_Occupy_Wall_Str

eet.mp4&reference=Shot&transcript=DialogueText&types=Shot,Volume,FieldSize,ImageIntri

nsicMovement,CameraMovementDirection,CameraAngle,RecordingPlaybackSpeed,MusicM

ood,SoundGestureDynamics,DialogueEmotion,BodyLanguageEmotion,MontageFigureMacro

,ImageContent,ImageBrightness,Setting,FoundFootage,ColourRange,DominantMovementDir

ection 

 

Note: The syntax of this URL will be explained in more detail in the paragraphs below. 

 

7.1.2.3. Display customization (URL, Edit Window, and syntax elements) 

At a very basic level, the AdA Timeline uses a text-based syntax for display configuration. This 

is encoded as a human-readable URL and adapted to the specific data structure of the AdA 

Filmontology. These text characteristics of the syntax allow you to independently create and 

edit visualizations using different settings. In addition, the Timeline can also be saved in a way 

that is better for further reference use or for sharing it, which improves the reproducibility of 

explorations. 

 

Changes to the display modes of the AdA Timeline can be made using various syntax elements 

either by directly editing the URL of the browser window, or through the text in the Edit Window. 

For the sake of clarity, we recommend adjusting the Timeline in the Edit Window. 
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The URL 

The AdA Timeline URL is made up of various modules that determine the visualization. 

 

 
 

For example, the URL begins with https://olivieraubert.net/hpi/timeline.html? or with 

http://localhost:1234/packages/advene/view/Timeline?. 

 

After this, various syntax elements can be implemented, for example “reference=” for setting 

the annotation type which you want to use as reference track, or “media=” to embed a video. 

After the “types=” element, you can specify the individual annotation types you want to see 

displayed in the visualization. The annotation type ID is used as name in this situation. The 

individual elements are separated from each other by an “&”. In the following example, the 

Scene annotation type has been set as reference track, and the Shot annotation type has been 

selected for the visualization: 

 

https://olivieraubert.net/hpi/timeline.html?reference=Scene&types=Shot 

 

For a combination of multiple annotation types, the IDs for the desired tracks are entered into 

the URL, separated by commas. In the following example, the annotation types Shot, 

ImageIntrinsicMovement and ImageBrightness have been selected for the visualization: 

 

http://olivieraubert.net/hpi/timeline.html?reference=Scene&types=Shot,ImageIntrinsicMovem

ent,ImageBrightness 

 

After the ID, different rendering options can be specified for each annotation type, in brackets. 

To do so, you have to enter the options to define the rendering format, for example 

“representation”, and separate it by a colon from the associated value; for example, 

“representation:hist” for display in histogram format. The input is always in the format 

RENDERING OPTION:VALUE. If several options are selected for one annotation type, these 

have to be separated from one another with a space – which in URL syntax is signified by a 

“%20”. 

 

https://olivieraubert.net/hpi/timeline.html?reference=Scene&types=Shot(representation:hist%

20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorschem

e:blues%20height:30),ImageBrightness(single_line:true%20colorscheme:greys) 

 

Note: All available syntax elements can be found here in a compact overview. 

 

  

https://olivieraubert.net/hpi/timeline.html?types=Shot(representation:hist%20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorscheme:blues%20height:30),LightBrightness(single_line:true%20colorscheme:greys)&reference=Scene(colorscheme:blues%20height:5)
http://localhost:1234/packages/advene/view/Timeline?data=../export/FlatJsonExporter&types=Shot,Volume,FieldSize,ImageIntrinsicMovement,CameraMovementDirection,CameraAngle,RecordingPlaybackSpeed,MusicMood,SoundGestureDynamics,DialogueEmotion,BodyLanguageEmotion,MontageFigureMacro,ImageContent,ImageBrightness,Setting,FoundFootage,ColourRange,DominantMovementDirection
https://olivieraubert.net/hpi/timeline.html?types=Shot(representation:hist%20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorscheme:blues%20height:30),LightBrightness(single_line:true%20colorscheme:greys)&reference=Scene(colorscheme:blues%20height:5)
http://olivieraubert.net/hpi/tl.html?types=Setting,CameraMovementDirection,CameraAngle
http://olivieraubert.net/hpi/tl.html?types=Setting,CameraMovementDirection,CameraAngle
https://olivieraubert.net/hpi/timeline.html?types=Shot(representation:hist%20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorscheme:blues%20height:30),LightBrightness(single_line:true%20colorscheme:greys)&reference=Scene(colorscheme:blues%20height:5)
https://olivieraubert.net/hpi/timeline.html?types=Shot(representation:hist%20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorscheme:blues%20height:30),LightBrightness(single_line:true%20colorscheme:greys)&reference=Scene(colorscheme:blues%20height:5)
https://olivieraubert.net/hpi/timeline.html?types=Shot(representation:hist%20colorscheme:redyellowgreen),ImageIntrinsicMovement(representation:hist%20colorscheme:blues%20height:30),LightBrightness(single_line:true%20colorscheme:greys)&reference=Scene(colorscheme:blues%20height:5)
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The Edit Window 

The Edit Window can be opened by using the “Edit” option at the top right of the screen. In it, 

you can adjust the display of the AdA Timeline by entering text. The Edit Window offers a better 

overview compared to making adjustments in the URL. 

 

 
 

Making adjustments in the Edit Window follows the same logic as making them in the URL, 

with minor differences in terms of input. 

 

The text in the Edit Window always begins with “data=timeline.json”. 

 

 
 

Various syntax elements can then be implemented, for example “reference=”, in order to 

specify the annotation type you want to use as reference track, or “media=” to embed a video. 

After the “types=” element, you can specify the individual annotation types you want to see 

displayed in the visualization. The annotation type ID is used as a name in this situation. The 

individual elements are separated from each other by an “&”. In the following example, the 

Scene annotation type has been set as reference track, and the Shot annotation type has been 

selected for the visualization. 
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For a combination of multiple annotation types, the IDs for the desired tracks are entered into 

the URL, separated by commas. In the following example, the annotation types Shot, 

ImageIntrinsicMovement and ImageBrightness have been selected for the visualization. 

 

 
 

After the ID, different rendering options can be specified for each annotation type, in brackets. 

To do so, you have to enter the options to define the rendering format, for example 

“representation”, and separate it by a colon from the associated value; for example, 

“representation:hist” for display in histogram format. The input is always in the format 

RENDERING OPTION:VALUE. If several options are selected for one annotation type, these 

have to be separated from one another with a space. 

 

 
 

Note: All available syntax elements can be found here in a compact overview. Making 

adjustments in the URL follows the same logic as making them in the Edit Window, with minor 

differences in terms of input. 

 

If you want to change the standard settings in the Edit Window, you can use the “Expand” 

option to display the presets for all annotation types. This can make it easier to adjust the 

Timeline for specific visualization needs. 
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In addition, you can access a brief overview of display options by using the “Help” option in the 

Edit Window. 
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Syntax element overview 

reference= specifies the annotation type used in the zoom bar as reference 

(most often Scene or Shot) 

transcript=  specifies the annotation type used as transcript 

media= embed a video or video player into the browser 

types=  the selection of displayed annotation types 

 

Setting for “types” Explanation Options 

representation see Rendering formats (histogram, bar 
graph, symbol, line chart, waveform) 

[hist, rect, symbol, line, 

wave] 

single_line single-line rendering (otherwise, 

different values are shown in separate 

rows) 

[true or false] 

predefined visualization is restricted to predefined 

values as defined under “Completions” 

[true or false] 

field definition of which aspect of annotations 

is taken into account: duration, the 

entire content of annotations, or 

separated individual values. (For 

example, in the annotation type 

Dialogue Text the duration of 

annotations can be displayed as a 

histogram if “duration” is specified as 

“field” and “hist” as “representation”. For 

tracks with different values which 

should each be displayed with 

“representation:rect”, you have to 

specify “parsed”.) 

[content, parsed, 

duration, ...] 

height visualization height in pixels (for 

histogram, waveform, bar graph, 

waveform, single-line) 

[numeric value  
(e.g. 60, 80 oder 200] 
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colorfield definition of which aspect of the 
annotation should be used for the color 
distribution (“content” is based on the 
alphabetical position of the text content 
of the annotation; “parsed” searches the 
annotation content for English color 
names, e.g. “sky blue”; “duration” 
decides based on the length of the 
respective annotation, e.g. blue-red 
spectrum for short-long distinction) 

[content, parsed, 
duration, ...] 

colorname if you select “parsed” for “colorfield”, the 

“colorname:true” option must also be 

specified, so that the bars of the bar 

chart (“representation:rect”) are 

rendered in a color corresponding to the 

annotation content 

[true or false] 

colorscheme color scheme (for histogram, bar, 

waveform) (The names of color 

schemes can be accessed at 

https://vega.github.io/vega/docs/schem

es/ 

[color scheme name  
(e.g. yellowgreenblue, 
viridis, inferno, …)] 

max_value sets a maximum value for numerical 
values (helpful, for example, if the 
credits distort the histogram of the 
entire film); if the value of an annotation 
exceeds the defined maximum value, 
this annotation is not displayed 

[numeric value  
(e.g. 20000)] 

legend a legend of all annotated values is 
displayed to the right of the visualization 
for the annotation type 

[true or false] 

labels a continuous timecode bar is also 
displayed along the annotation type 

[true or false] 

 

 

7.1.2.4. Saving Timeline settings 

The easiest way you can save and share Timeline settings is to copy the content of the Edit 

Window to a word processor of your choice and save it there. When you open a new AdA 

Timeline, replace the entire content of the Edit Window with the saved content and confirm this 

action with “OK”; the settings will then be applied to the new Timeline as well. Settings made 

for a specific project can thus be transferred over to other projects, as long as they are also 

based on the AdA Template. 

 

  

https://vega.github.io/vega/docs/schemes/
https://vega.github.io/vega/docs/schemes/
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7.1.2.5. The Type Selector 

The Type Selector, a graphical interface meant to simplify adjusting the AdA Timeline, is 

currently still in development. The respective annotation type can be shown or hidden by either 

selecting or deselecting the eye symbol. The gear symbol opens the settings options for the 

respective annotation type and allows you to adjust these settings. 

 

 
 

Note: At present, the Type Selector does not yet work perfectly, which is why we recommend 

using the Edit Window to adjust the display. The range of features is identical for both 

adjustment methods. 

 

7.1.3. Embedding a Video (player) 

In the AdA Timeline, there is a direct link between the displayed annotations and the Advene 

video player, which means that when you click on any annotation in the AdA Timeline the video 

player in Advene will jump to the corresponding position. 

 

Alternatively, the video can also be embedded directly into the AdA Timeline through a video 

player. To do so, a local web server must be opened via a browser plug-in, from which the 

visualization can then stream the video. For the Chrome and Chromium browsers, you will 

need to install the “Web Server for Chrome” plug-in and select the “Web Server” option in the 

tab that opens in the browser. 
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Link for the plug-in: https://chrome.google.com/webstore/detail/web-server-for-

chrome/ofhbbkphhbklhfoeikjpcbhemlocgigb?hl=en 

 

A new tab will open where you can configure the plug-in. Select “CHOOSE FOLDER” to select 

the local folder that contains the desired video file. 

 

 
 

You can now test whether the browser plays back the video. To do this, enter the URL of the 

local web server into the browser: http://127.0.0.1:8887 

 

Note: The port number at the end of the URL can vary depending on your plug-in settings. 

 

This local video URL can now be copied and specified as source in the Edit Window of the 

AdA Timeline. To do this – as in the example below, 

“&media=http://127.0.0.1:8887/Maltsev_Sem_Occupy_Wall_Street.mp4” – integrate the video 

URL into the Timeline as “&media=http://LOCALHOST:PORT NUMBER/FILE NAME.mp4”. 

 

 

https://chrome.google.com/webstore/detail/web-server-for-chrome/ofhbbkphhbklhfoeikjpcbhemlocgigb?hl=enA
https://chrome.google.com/webstore/detail/web-server-for-chrome/ofhbbkphhbklhfoeikjpcbhemlocgigb?hl=enA
http://127.0.0.1:8887/
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The video will now be displayed alongside the AdA Timeline. 

 

 
 

Note: Embedding a video using this method works both for local and web-hosted Timelines. 

 

7.1.4. Exporting the AdA Timeline 

By clicking the three-dot symbol at the top left of the screen and selecting the desired option, 

you can export the AdA Timeline. If you wish to use static illustrations of AdA Timelines for 

publications and presentations, we recommend exporting them as PNG files by selecting 

“Save as PNG”. 

 

 
 

The complete Timeline will be exported as one image, even if parts of it are currently situated 

outside the visible area of the browser window. 

 

Tip: We recommend paying extra attention to the position of your mouse pointer when 

exporting. If the mouse pointer is moved over an annotation, this annotation will be highlighted 

in yellow, which will also be reflected in the exported file. 
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7.2. The Annotation Explorer 

In order to enable cross-film searches and comparison, a web platform – the Annotation 

Explorer – was developed under the direction of Henning Agt-Rickauer in collaboration with 

Joscha Jäger (https://frametrail.org/). This web application allows you to collect data created 

in Advene into a comprehensive corpus database and present it as a web application that can 

be searched and explored in a variety of ways. The Annotation Explorer’s data management 

is in line with the linked open data principles. The various annotation levels are supplemented 

by further automatic extractor results and presented in interaction with the actual films in a 

comprehensively adjustable interface. 

 

These extractors currently include: 

- The creation of a visual index for the corpus (AdA development: Christian Hentschel 

& Jacob Löbkens), 

- The classification of the aspect ratio (AdA Aspect Ratio Extractor (Hentschel & 

Löbkens)),  

- Speech recognition (based on Mozilla DeepSpeech – 

https://github.com/mozilla/DeepSpeech/), 

- Concept Detection (DenseCap Frame Captioning (Johnson, J., Karpathy, A., & Fei-

Fei, L. 2016) – https://github.com/jcjohnson/densecap; Video Frame to Text Extractor, 

im2txt: https://github.com/tensorflow/models/tree/archive/research/im2txt),  

- Motion detection (AdA Motion Dynamics Extractor (Hentschel & Löbkens)), 

- Cut detection (Shot Boundary Detector – https://github.com/johmathe/Shotdetect),  

- Volume detection (Sound Envelope Extractor), 

- A classification of music, voice, noise & silence (YAMNet Audio Event Classification – 

https://github.com/tensorflow/models/tree/archive/research/audioset/yamnet).  

 

For the purposes of this manual, the Annotation Explorer serves as an example of how film 

analysis data based on the AdA Filmontology can be used for other applications. Setting up a 

personal, server-based Annotation Explorer requires a high level of technical skill, the detailed 

explanation of which would go beyond the scope of this manual (see 

https://github.com/ProjectAdA). Instead, the following explanations focus on the user 

perspective: How can complex and extensive data sets be visualized for exploration? How can 

you make comparisons between different films within the corpus? What other forms of corpus 

exploration are possible beyond these? 

 

For copyright reasons, a large part of this corpus is not freely accessible and can only be 

viewed by internal users who have registered an account. The interlinking of visualizations and 

video players can hopefully be understood by external users based on the public domain 

videos dealing with the Occupy Wall Street movement. 

 

The Annotation Explorer of the AdA Project can be found here: 

http://project1.ada.cinepoetics.org/explorer/ 

 

Examples of use in other contexts can be found here: 

https://intern.ada.cinepoetics.org/explorer  

 

https://frametrail.org/
https://www.w3.org/DesignIssues/LinkedData.html
https://github.com/ProjectAdA/ada-va/tree/main/ada-va/extractors/aspect_ratio
https://github.com/mozilla/DeepSpeech/
https://github.com/jcjohnson/densecap
https://github.com/tensorflow/models/tree/archive/research/im2txt
https://github.com/ProjectAdA/ada-va/tree/main/ada-va/extractors/motion_dynamics
https://github.com/johmathe/Shotdetect
https://github.com/oaubert/advene/blob/master/lib/advene/plugins/soundenveloppe.py
https://github.com/tensorflow/models/tree/archive/research/audioset/yamnet
https://www.ada.cinepoetics.fu-berlin.de/en/ada-toolkit/index.html
https://github.com/ProjectAdA
http://project1.ada.cinepoetics.org/explorer/
https://intern.ada.cinepoetics.org/explorer
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7.2.1. The user interface 

Alongside a brief introduction, the Annotation Explore homepage contains a few sample search 

queries that should provide you with an introduction to its use and its various facets. The 

Annotation Explorer allows you to search, filter, and visualize annotation data in a wide variety 

of ways. For example, annotations for individual scenes or films (“AdA Filmontology & Video 

Player Interaction – ‘Occupy Wall Street’”) or in a (scene) comparison for multiple videos 

(“Detailed Video Comparison – Two Occupy-Wall Street Videos”) can be displayed. Across 

corpuses, you can search for individual or combined values (“Combined Value Search – Sad 

Music + Close Field Sizes”), specific keywords, motifs, or names. Such queries can be 

supplemented by further search queries. In addition to comparative detail studies, annotation 

data can also be visualized for entire films in order to give you an overview of the dynamic 

macro-dynamics at work (“Macro Dynamics Full-Length Feature Film – ‘The Company Men’”). 

Automatically generated annotations can be displayed for individual films (“Automatically 

Generated Annotations – ‘The Margin Call’”), for a selection of videos (“Comparison of 

Automatically Generated Annotations for several Feature Films”), or even in comparison with 

manual annotations (“Automatically Generated vs Manual Annotations – Segments of Music 

and Speech”). If you move the mouse pointer over the searches, short descriptive texts will 

appear; clicking them will load up the respective query. 

 

 
 

In the following paragraphs, we will divide the user interface into function areas, and we will 

describe each of them in more detail. 
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Show/hide function areas 

You can toggle showing/hiding the Query Box and Search Filter on the left side, as well as the 

Video Player and Transcript Viewer on the bottom side, by using the arrow buttons (marked 

“Minimize” in orange in the screenshot above). 

 

7.2.1.1 The Query Box 

The Query Box is situated on the left side of the interface. It is the central input field for loading 

semantic annotation data (Linked Open Data) into the Annotation Explorer. 

 

Searching by annotation types 

 

To load annotations, all three fields must be filled in. If 
you click on “Submit”, the selected annotations will be 
loaded in the Workspace. 
 
Warning: The “All Scenes” and “All Types” filters can 
contain a very large number of annotations. This can 
significantly slow down the loading time. We recommend 
refining your search as much as possible. Multiple films, 
scenes, and types can be selected (separated by 
commas). The results for a search query remain in the 
Workspace when another search is performed 
(“Displaying search queries”). There are two additional 
predefined groups of annotation types: “Auto Types” 
displays all fully automatically created annotation types, 
while “Corpus Analysis Types” displays the base tracks, 
a selection of types that is recommended for the manual 
annotation of corpora. 
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Text search 

 

The plain text search can be used to search for keywords 
in one or multiple films, keywords such as “money”, 
“crisis”, or “Wall Street”. The search query can also be 
limited to specific annotation types. 
 
Deselecting the “Find whole words only” option allows 

you to also find fragments of words. 

 

 

Image search 

 

A corpus can be searched for visual similarities using 
the picture-to-picture search. 
 
You can upload a locally saved image via “Select an 
image”. The number of search hits defined by “Max 
results” will then be displayed in a search bar. By 
specifying the films, the timecodes, and the calculated 
similarity (“Distance”), the most similar shots in the 
corpus will be displayed (the shorter the calculated 
distance, the more similar the images will be). 
 
The “Download” button allows you to download the 
search results in table form as an html file. This can be 
useful for archiving search queries and for providing you 
easy access to search result metadata. 
 
In this manner, circulating image types and recurring 
found footage material can be found within an entire 
corpus. 

 

Searching by value 

 

You can use “Values” to search for specific values of 
individual annotations. These values represent film 
analysis concepts defined in the AdA Filmontology. 
Several values can be searched for simultaneously 
(you have to separate them by commas). By using “+”, 
you can select up to five values for this search, in order 
to filter the occurrence of different values in 
combination, i.e. in chronologically overlapping 
annotations. You can restrict your search to certain 
films by using “Movies”. 
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7.2.1.2. Search filters 

The search filters do not allow data to be loaded into the workspace,they only allow for the 
data already present in the workspace to be filtered. For instance, films or specific types or 
values can be deselected this way. The workspace will then be automatically reloaded after a 
few moments. If you make several changes in quick succession, the content will only be 
reloaded when you have not made any changes for a few moments. 

 
Movies: Documentary/Feature/TV 

 

Data of a search query that has already been loaded 
into the workspace can be filtered by category: 
documentary, feature film, news segment formats, or 
individual films. The drop-down menus for the 
individual categories can be opened by clicking the 
small arrows to the left of the respective checkboxes. 

 

Annotation Types and Values 

 

Already loaded annotations can be filtered here by 
annotation level, annotation type, and annotation 
value. For example, this allows you to display close-
ups exclusively, while other field sizes are not 
displayed. The systematic for annotations is based on 
the AdA Filmontology. 
 
You can use “Select: All | None” to select or deselect 
annotation types faster. “Expand: Level | All | None” 
allows you to expand or collapse the drop-down 
menus. 

 

 

7.2.1.3. The Workspace 

Individual annotation types will be displayed as tracks in the Workspace; their names are 

shown on the left-hand side, above each track. The order of these types can be changed 

directly in the Workspace by using drag-and-drop. 

 

Displaying search queries 

 
 

Each search query will be displayed at the top of the Workspace as a long box with a short 

description and can be deleted by clicking on the X. All search queries can be deleted by 

clicking the “Clear Workspace” button on the top right. The Workspace will then be reloaded. 

The “Download Result” button can be clicked to download the Workspace as a static html file. 
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Sorting and zooming 

 
 

At the top right of the workspace, you can zoom in and zoom out by clicking on the two 

magnifying glass symbols. Depending on the type of search (i.e. in the list view), you also have 

the option to sort the Workspace alphabetically based on the annotation type designations or 

on the film names. 

 

The “Filter Scenes“ option 

 
 

If the Movie View is activated, a bar with scene segments will be displayed above the loaded 

annotations in the Workspace. By clicking on a single scene, the display will be limited to that 

particular scene. Click on “Remove Scene Filters” to switch back to the general overview for 

the entire film. 

 

The Video Player 

 
 

The Video Player is located in the lower left area of the Workspace. When you select an 

annotation, the player will automatically jump to the corresponding timecode. You can thus use 

play or pause to view the video material guided by annotations. 

 

Note: The Video Player and Transcript can be minimized using the arrows in the middle (see 

screenshot above), in order to allow you to see more annotation types in the Workspace at the 

same time. 

 

Note: For copyright reasons, only two videos dealing with the Occupy Wall Street movement 

can be streamed freely. Temporary access to all videos can be requested for specific research 

purposes. 
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Transcript and Image2Text 

   
 

Manually created transcriptions of spoken language are displayed on the right of the Video 

Player if you click on the microphone icon. The image symbol enables you to switch to the 

automatically generated Image2Text, a rough description of the visible picture content. By 

clicking on a line in the window, the Video Player and the pointer in the Workspace will jump 

to the corresponding position. The Transcript and the automatic image recognition can be 

accessed through the full text search function as well. 

 

Number of search results 

The number of search results is displayed in the Player View on the bottom edge of the screen. 

The two currently displayed search results – each with a corresponding Video Player in the 

Workspace – are highlighted in white. 

 

 
 

The arrows on the right and left sides of the Workspace allow you to navigate between search 

results. 

 

7.2.1.4. Explorer Settings 

In the top bar on the right, above the Workspace, you can find a series of switches that can be 

used to change the display mode of search queries in the Workspace. 

 

 
 

(Visualization) options for annotations 

Charts 

Sequential annotation types can be displayed as column diagrams by using this switch, i.e. the 

column height of annotations corresponds to the ratio of the ordered values. The columns for 

the values “high” or “5” are therefore higher than those of “low” or “1”. This option only applies 

to annotation types that are ordered along a scale. 
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Scale 

This switch can be used to display horizontal lines in certain tracks, as an orientation aid for 

better comparability of the height of the individual annotations on a track. This option only 

applies to annotation types containing values that can be arranged by column size difference. 

 

 
 

Colors 

Different values within an annotation type or even individual annotations are rendered in 

contrasting colors in order to visually delineate their distribution and surface area within a track. 

If this option is disabled, the individual annotation types will be displayed in differentiated 

monochrome, so that the contrast to the other tracks remains clearly visible. 

 

 
 

Legend 

This switch allows you to display – or hide – annotation values for each annotation type directly 

above the corresponding track in legend format. 

 

 
 

If you move the mouse pointer over one value, all other annotations disappear, so that only 

the marked value remains visible. If the “Colors” option is enabled, the values in the legend will 

also be differentiated by color. 
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View Modes 

 

Movie/Scenes 

The “Movie” view is based on the film in its entire duration, and therefore also shows all tracks 

in their entire length. Depending on the film and the annotation type, annotations are often too 

small to recognize structures on this level; to bypass this, you can use the “Filter Scenes” 

option to zoom in from the general overview to individual scenes. 

 

The “Scenes” view is based on individual scenes as objects of study and therefore scales down 

to the scene level. If you search an entire film, the Workspace will be split into two, so that two 

scenes can be displayed at the same time. The arrows on the edge of the Workspace can be 

used to change to the next scenes (if they have been loaded in the search query). 

 

Player/List 

This switch can be used to switch between the Video Player and Transcript view to a list view. 

The “Filter Scenes” option is only available in the Player View. The “Sort by Movie” and “Sort 

by Type” options are only available in the “List” View. 

 

Video Source Settings 

Clicking on the small wheel symbol on the top right corner of the top bar will open a window in 

which the video file source can be changed. If one of the annotated films is available as an 

mp4 file, a local path can also be specified. Similarly, you can also use video platform URLs – 

unfortunately, a large part of the films in the AdA Corpus is not publicly available at this time, 

so they can only be linked to the Video Player via a secure Vimeo account. If you want to play 

all videos, you have to open a new browser tab and log in to Vimeo with a corresponding 

account. 

 

Timeline Order 

Click on the list symbol at the top right to open a window in which you can define an order for 

the display of annotation types. Tracks that have been marked in this way can then be 

prioritized even after the current search query has been deleted – until you close the window 

or end your session in the Annotation Explorer. Annotation types can be loaded by using an 

input field. You can restore the original order by using the “Reset Prioritized Types” option. 

 

7.2.1.5. Downloading/Exporting 

By clicking on the “Download Result” switch at the top right of the Workspace, the currently 

displayed search results can be downloaded as an html file. It can then be opened offline in a 

browser or distributed. The view options can no longer be changed there, but you can click 

through all the scenes contained in the search query, and you can also scroll through all the 

annotation types. The Video Player will work as long as there is access to the video – the path 

can be changed by clicking on the small wheel icon at the top right (see "Video Source 

Settings"). Clicking on “Live View Results” also on the top right will open the search query in 

the Annotation Explorer. This will allow you to reselect the results in the query, as well as to 

add further search queries. 
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Individual annotation type data can also be downloaded as a CSV table. To do so, move the 

mouse pointer over the respective annotation type until the “Export Data” button appears. Once 

you click this button, a download window will appear. 

 

 
 

These CSV files will then allow you to edit them in other software programs. For example, it 

will enable you to import these files into your own Advene packages. 

 

 

7.2.2. Search query example: Occupy Wall Street 

Using a license-free video on the Occupy Wall Street movement, we will provide you with a 

step-by-step guide for a search query example. 

 

Visualizing annotations for an entire video 

First, the name of at least one film has to be selected in the topmost Query Box on the left-

hand side of the screen. For a rough overview of the annotations associated with the video, 

the standard settings “All Scenes” and “All Types” can be left in place for the “Scenes” and 

“Types” rows. Clicking “Submit” will load the search query into the Workspace. 

 

 
 

Annotation types are listed below one another in the Workspace; all others can be viewed by 

scrolling up or down, and their order can be changed via drag-and-drop. 

 

Clicking on an annotation will display its content and make the Video Player jump to the 

position in the video to which the annotation is referring. This allows you to directly view it and 

relate it to its annotation values. The Transcript at the bottom left of the Workspace provides 

you a quick look at the spoken dialog at the selected time. The picture symbol underneath the 

microphone symbol changes from the Transcript to a rough description of the picture content. 
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Clicking on a row in the Transcript/Text2Speech window makes the player jump to the 

corresponding position in the video. 

 

Filtering by annotation level 

If you need to specify the annotation type views more precisely, a certain annotation level can 

be filtered in the bottom section of the search query. To do this, all other annotation levels must 

be deselected, for example via “Select None”. 

 

A combination of annotation types from different levels can also be selected in this manner. 

 

 
 

For a more detailed insight into annotation values, their progression, and the relationship 

between annotation types, we recommend changing the view mode. In this example, we made 

a change in the visualization bar at the top right from “Movie” to “Scene” and from “Player” to 

“List”. (Alternatively, the Player can also be collapsed in the “Player” view, in order to see 

further annotation types simultaneously on the screen). 

 

Certain patterns have now become visible in the annotations: After the first third, a turning point 

can be noticed; the last third stands out. 
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Comparing two scenes using the Image Composition example 

Based on the results from the previous sections of this guide, it may be interesting at this point 

to compare the values and patterns found to another film or to another scene. 

 

To do so, you have to select another film or scene in the query and load it. The previous search 

query will remain in place; only “Clear Workspace” deletes previous search queries. 

 

The Workspace will now be automatically split in two, so that both films can be displayed side 

by side. 

 

 
 

Both areas of the Workspace can be scaled down to a scene view by using "Filter Scenes" or 

changing the view mode to "Scenes". This allows you to already perform a rough comparison. 

 

If you need to examine a certain annotation level in both scenes in more detail, you can select 

this level on the bottom right in the query. You can optimize the Workspace for this specific 

comparison by changing the visualization option, the view modes, the track order, as well as 

the zoom level in the Workspace. 

 

Filtering by value 

Because of the prominently visible monochrome sequence in the second video, it may be 

interesting to examine the use of high-contrast black and white footage in other films or news 

segments about the financial crisis. This can be done by adding another search query without 

having to select a specific film or type. For this purpose, the rows in the first tab of the top query 

area will be left empty. On the top left of the query, under the fourth tab, you have to specify 

the values “black”, “white”, and “bright-dark” in separate rows, which can be added by using 

the “+” symbol. 
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Filtering by plain text 

The plain text search can now be used in an exploratory manner to search for motif fields. The 

search term “statue” can be used to search for verbal mentions in the dialog text or for pictures 

in which the automatic concept detector assumes a statue might be present. Other terms such 

as “storm”, however, will also produce search hits in the noise detector. Due to the bilingual 

nature of our reference corpus, we recommend sometimes searching simultaneously both for 

the English and German term (for example, “boat” and “boot”), in order to obtain both the 

results from automatic detectors and transcriptions of the German dialogs. By deselecting 

specific annotation types in the sidebar, you can compensate for some of the false hits from 

the automatic detectors. 

 

7.2.3. Troubleshooting 

If you encounter problems while using the Annotation Explorer, we recommend the following 

steps: 

- Reload the webpage multiple times (this can often fix problems related to the cache) 

- Change the browser (based on our experiences, we recommend Mozilla Firefox and 

Google Chrome) 

- Search queries with many hits can easily result in long loading times since several 

video players are often started in the background. We recommend reloading and 

narrowing down your search results. 

- If no video is visible, this does not mean a technical error has occurred. Most videos 

are not freely viewable for copyright reasons. Access data can only be granted 

temporarily for specific research projects. 

- For extensive result displays, the loading time may be rather long, in particular when 

using computers with lower amounts of RAM. Loading times of up to seven minutes 

are therefore not uncommon, and they do not mean that the application has stopped 

working. 

- URLS can be used to share and distribute search results. If the system needs to be 

reinstalled, film IDs may change. A long-term archiving solution of search queries 

should therefore be implemented using the download function. 
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